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Resumo

Até a data, o cinema de animacdo conta as historias de personagens que representam
animais ou maquinas, criaturas oriundas do imaginario ou até humanos em forma de cartoon.
O grande desafio permanece a concepcdo de um filme de animacdo com personagens
humanos fotorrealistas; as tentativas nesse sentido tém sido alvo de criticas, por despertarem
um desconforto psicoldgico no espectador, ao observar algo que parece e se move quase como
um humano. No entanto, o facto de, em menos de 20 anos, a industria da criacdo digital ter
evoluido do jogo Pac-Man para o filme Beowulf — em que os actores séo todos gerados por
computador e, contudo, facilmente reconheciveis — deixa acreditar que ndo tardara muito para

que se torne dificil distinguir entre actores reais e digitais.

Também a industria dos videojogos tem apostado cada vez mais no aspecto fotorrealista,
a par da continua evolucdo das plataformas, embora tenha sempre o cuidado de usar baixas
resolugdes, de modo a que o computador possa gerar as imagens em tempo real, tornando
assim possivel a jogabilidade. Todavia, uma grande parte dos videojogos contém excertos
cinematograficos em que a modelacdo e animacdo sdo criadas tao fotorrealisticamente quanto

possivel, dado que as imagens sdo geradas previamente.

As personagens constituem um dos elementos mais fulcrais de qualquer histdria, se ndo o
mais importante. Sem elas, ndo ha histdria. Quando se trata de um filme ou de uma animacao,
a importancia da personagem ganha outra dimensdo, em que a sua aparéncia, 0 modo como se
move e as suas expressOes faciais ajudam muitas vezes a contar a historia e a passar
sentimentos ao espectador. O rosto €, sem qualquer duvida, o elemento mais importante de
uma personagem; ndo é por acaso que, normalmente, quando duas pessoas conversam, se
olham face a face. Através do rosto, expressamo-nos emocionalmente, consciente ou

inconscientemente.

Esta dissertagdo propde-se acompanhar o processo de criagdo do modelo tridimensional
do rosto de uma personagem humana masculina realista. Terd como ponto de partida a
concepgdo das imagens que Ihe servirdo de referéncia, passando por uma breve abordagem as
ferramentas e técnicas de modelacdo no software Maya, da Autodesk, enunciando
posteriormente 0 método de modelacdo de cada um dos elementos que constituem o rosto
humano. Seguidamente, acompanhara a transicdo do modelo para o software ZBrush, da
Pixologic, onde o nivel de realismo do rosto sera elevado com recurso a ferramentas mais

intuitivas.
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Abstract

Until now, computer-animated films have told the stories of animal characters, fantasy
creatures, machines or even cartoon-like humans. The big challenge in this medium remains
the photorealistic animation of humans; so far, most attempts have been criticized, for
triggering in the spectator a distasteful psychological response to viewing nearly perfect
animation of humans. Nevertheless, the fact that, in less than 20 years, the industry of
computer-generated imagery has evolved from the game Pac-Man to the movie Beowulf - in
which all actors are generated by computer and, still, easily recognizable - lets us believe that
it won't be long until we can barely distinguish between real and digital actors.

The video game industry is increasingly developing products using a photorealistic look,
as gaming platforms are continuously evolving. In spite of this evolution, playability requires
console processors to generate images in real time, and often lower resolution images have to
be used. However, a large number of videogames contains cinematographic excerpts in which
modeling and animation are created as photorealistically as possible, since the images are

generated beforehand.

This dissertation proposes to study the creation process of a three-dimensional model of a
realistic human face. It begins by describing the conception of the images that will serve as
reference, going through a short approach of the modeling tools and techniques used in Maya
software, by Autodesk, describing the method that is used to model each element that
composes the human face. Finally, it follows the transition of the model to ZBrush software,

by Pixologic, where the model's realism will be increased with more intuitive tools.



Modelacdo do Rosto Humano Realista

indice de Contetdos

R i oo U Tt T O O PP PP PP R PPPPPN 2
1.1 Apresentac@o da Proposta de Trabalno..........c..oooiiiiiiiiiiii e 2
1.2 Estudo e Desenvolvimento do Projecto FiNal.............oooiiiiiiiiiiii e 3
1.3 Organizacéo e Temas Abordados na Presente DISSEragao.........ccceevrueeeiriiieiiiiiee i 4

2 CaracterizaGao U0 PrOJECLO ......ueeeiiiteieetitite e ettt e e ettt e e ettt e e e sttt e e e st be e e e e s br e e e e asbe e e e e anbr e e e e anbeeeeeanbneeeeaneee 5
2.1 Descrigdo e Objectivos
N NN 1= (0 ) 4 - VRSOSSN
2.3 INFIUBNCIAS ...ttt ettt 7
2.4 Pesquisa Efectuada para a Pré-ProduGa0 dO PrOJECIO .........ccvvueeeiiiiieeiiiieesiieeeesiieeesaee e eeeeeenneaeeeens 8
P I ©1o ] (o] [ 1= To Jo [ @F=T o 1101 (o P UPPSPPPPPRPR 8

I S (A V(ST To e [o I L) = To [0 o L= N0 AN 1 (PRSP PPRPRR 9
I R BT {1 fo= Lol = 1 5S] (o 4 T= W [0 1N X ] PSPPSRI 9
3.2 A Modelag&o de um Rosto Humano Realista

3.2.1  ArtiIStAS REIEVANTES ......eiiiiiiiiiiieeiee ettt
3.2.2 Apresentacdo do Software AUtOAESK MAYa ..........coccueieiiiiiiiiiiiieiiece e 25
3.2.3 As Principais Ferramentas de MOEIAGAO...........cceiiuiieiiiiie e 26
3.2.4 ASIMAgENS A€ REFEIENCIA ... cciiiiiii ittt 31
3.2.5 MOAEIAGA0 A CADEGA ...eeeiiviieiiiiie ettt ettt e e et e e st e e s na e e raeeean 33
3.2.5.1 O INErIOr da BOCA ......eeiiiiiiiiiiiiiit ettt 52
3.2.5.2 O OIN0 ..ttt 55
3.2.6 Apresentacdo do SOftWAre ZBrUSK ..........ccviiiiiiiiiiiiiee e
3.2.7 A TUNGEAD GOZ ...ttt ettt e e e e e ettt e e e e e s e bbb e bt e e e e e e e e e s
3.2.8 Introducao as Principais Ferramentas de Modelacao
3.2.9 Elevando o Nivel de Realismo do ROSt0 HUMANO ........cccuvviiiiiiiiiiiiee e
3.2.10 Displacement Map/ NOMEAL IMBP ......cvveeeiiiiiieiiiie ettt e e
G I 70 (o] 18 EY= To I o [ @Y o 11 11| o PRSP 69
4 Desenvolvimento do ProjeCto FINAL.........coouuiiiiiiiiiiiiie e 70
T = (T (o To 11 oT= o T PR SPRP 70
4.1.1 Argumento - A Evolucdo da Narrativa
4.1.2 Storyboard e AnimatiC..........cuveeeeeeiiiiiiiiieeeenn.
4.1.3 Imagens de Referéncia do PersOnagem .........couiiiiiiiiieiiiiee e 72
O |V T Yo (0o I e (o T =T o =g T PSR 73
N o (oo (1 Tor- Lo PP P PP UPPPPRPPI 74
o R Y T To (=1 = o= o e [0 I =T = 14 T 1 PSSR 74
o S R O o ¢ £ To [0 O OO PP PP PP OPPPPTP 75
N 2 @ - o Yo T - (o] [ 1 OO RR 76
4.2.1.3 OS LAVADOS ....ceiiiiiiiii s 76
4.2.2 Modelagao dos Personagens € ACESSONIOS .......c.ueieriuereeiiuieeeaaieeesaieeeeaseeeeaaeeeesaneeeesanneess 77
4.2.3 Texturizagédo
o = (o o |1 o PP PPRT PP
N SR N g [0 = Tor- To T O PSPPSR P PP OUPPPPPPI
o T 110 o 11 o F=Tok= Lo TP PPPT TP 81
N N = 0T 0 [o (=T 4= Tor= Lo B O PP PU PP OUPPPPPPI 82
e B oo F- o (0o 11 Lo T TR 83
4.4 CONCIUSEO A€ CAPTIUIO .....eiiiiiiieeie ittt e bbbt e e s b e e e st e e nbe e e e s nneeas 83



Modelacdo do Rosto Humano Realista

5 Conclusdes e Perspectivas de Trabalno FULUIO ..........oocuviiiiieie e e e e 85
Refer@ncias @ BiHOGIafial .........ocuuiiiiiii e 87
RV T L= - - SO 88
Anexo A: Cronologia de eVENIOS A0 CGl .....ciiiiiiiiiiiiiii et 91
ANEXO B DVD oo 92
Y g[S (o J O @1 o]0 o Ts | = o 1 - VPO O PP PR PPUPPPI 93

Vi






Modelacdo do Rosto Humano Realista

1 Introducéo

Este primeiro capitulo consiste na apresentagdo e descricdo do projecto final e suas
diferentes etapas, expondo o tema tratado na Dissertacdo e culminando na referéncia ao modo

como o documento esta estruturado.

1.1 Apresentagdo da Proposta de Trabalho

Quando confrontado com o desafio de desenvolver um projecto final de Mestrado, pensei
em criar algo que transmitisse verdadeiramente 0s meus interesses, 0 que me move, aquilo
que gostaria de fazer na minha carreira profissional. Tive, no entanto, que ser prudente e
manter os pés bem assentes na terra, para ndo entrar em grandes producfes que depois

correriam o risco de ndo serem concluidas a horas e com a qualidade conveniente.

Antes de avancar para algo mais concreto, a primeira grande questdo com que me deparei
no respeitante a futura carreira profissional prendia-se a indecisdo entre querer vir a ser
modelador ou animador; se queria que o0 meu projecto final mostrasse aquilo que quero fazer
como profissdo, era conveniente saber responder a essa questdo. Contudo, ambas as areas me
fascinam, talvez de igual modo, pelo que seria dificil optar por uma e deixar a outra em
segundo plano. Pensei que, talvez com o decorrer do desenvolvimento do projecto percebesse
qual das duas areas tem, de facto, mais significado para mim, pelo que néo fiz a escolha nessa

altura, apostando num projecto que daria igual importancia as duas vertentes.

The Night Shift € um projecto individual que nasceu da ponderacdo de todos esses
factores; retine grande parte dos meus interesses, como a ficcdo cientifica, a modelacdo 3D
realista e a linguagem cinematografica dos videojogos, a0 mesmo tempo que conta uma
historia concisa e considerada passivel de ser concretizada no periodo de um ano lectivo. Na
verdade, o facto de ter optado por uma linguagem realista acarretou bastante mais trabalho do
que inicialmente esperei; foi preciso ter atencdo a inumeros detalhes, nada pdde ser deixado
ao acaso, o que multiplicou consideravelmente as horas dedicadas ao trabalho. Por outro lado,
antevendo vagamente a carga de trabalho que adviria, comecei a tentar conceber uma historia
gue exigisse modelar uma Unica personagem. Surgiu, assim, a ideia de utilizar duplamente a
mesma personagem, motivando a criagdo de um enredo remetente para a ficcdo cientifica,

envolvendo uma perseguicdo entre um agente secreto e o seu clone.
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A Dissertagdo tem como tema a Modelagdo do Rosto Humano Realista, incluindo um
guido completo para a criacdo do modelo de uma cabega humana realista topologicamente
preparada para animacéo, por meio dos softwares Maya e ZBrush, tomando como exemplo o

préprio modelo do projecto final.

1.2 Estudo e Desenvolvimento do Projecto Final

Devido a alguns atrasos e complicacGes decorrentes de um projecto anterior, 0 guido de
The Night Shift so6 foi fechado no dia 30 de Outubro de 2010, com o apoio dos professores
Ricardo Megre e Pedro Serrazina. Procedeu-se imediatamente a concepcdo do animatic, que
foi aprovado no dia 5 de Novembro. Nesse dia, foi criado o cronograma (anexo C), com a
supervisdo dos professores, estabelecendo-se as datas designadas para cada fase da producdo
do projecto. O dia seguinte foi dedicado a criacdo das imagens de referéncia da cabeca da
personagem. A modelacdo da cabega no Maya comegou no dia 10 de Novembro, estando
quase concluida uma semana depois. No dia 19 de Novembro, a primeira versdo do corpo e
roupa da personagem no Maya estava também terminada. Os professores deram o seu parecer
e, no dia 24, o corpo estava muito préximo de finalizado ja& no ZBrush. Deu-se inicio a
modelacdo dos acessoérios, fase que se prolongou até ao fim de Dezembro, juntamente com a

planificacdo dos UVs de todos os elementos respeitantes a personagem.

No dia 18 de Janeiro, teve inicio a fase de texturizacdo da personagem, na qual se
pesquisou e atribuiu texturas que mantivessem a coeréncia realista a personagem e respectivos
acessorios. Nesta etapa, procedeu-se ainda a pesquisa e estudo de um aplicativo que
permitisse criar 0 pélo e cabelo da personagem, o Shave and a Haircut, embora se tenha
acabado por optar pelo Maya Fur, o aplicativo basico do programa concebido para 0 mesmo

efeito, que deu resultados satisfatorios. Esta fase ficou terminada no dia 26 de Janeiro.

Teve, depois, inicio a fase de rigging (processo através do qual se constréi um conjunto
hierarquico de ossos interligados - o esqueleto ou rig - utilizado para animar 0 modelo), em
que, recorrendo ao aplicativo The Setup Machine 2.0, da Anzovin Studio, se criou, de um
modo mais automatico, o esqueleto da personagem. Para poder ter um grande controlo sobre a
animacdo das expressdes faciais, tentou criar-se o esqueleto facial através de um processo
idéntico, utilizando um aplicativo do mesmo estudio, The Face Machine, mas tendo-se
deparado com alguns problemas irresoliveis, acabou por se conceber o esqueleto facial
através de um processo mais manual e trabalhoso, com base em blendshapes - deformacdes

pré-definidas.
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Posteriormente, chegou a fase de modelacdo do cenario, constituida por uma primeira
parte, em que se fez um mock up, ou seja, uma versao apenas com 0 apontamento dos seus
elementos e respectivos volumes, procedendo-se depois a pormenorizacdo, seguida da
texturizacdo. Com isto, ficou o terreno pronto para a animacgdo, que ocupou uma grande
porcdo do 2° semestre. Seguiu-se a etapa da iluminacdo do cenério e, por fim, chegou a fase
de renderizagdo, em que se exportaram as imagens que viriam a constituir o filme, dando-lhes
depois o tratamento que precisaram em pos-producdo, como correcces de cor e ajustes de

brilho e contraste.

1.3 Organizagédo e Temas Abordados na Presente Dissertacéo
Posteriores ao capitulo da introducdo, seguem-se outros quatro;

- 0 capitulo 2 destina-se a caracterizacdo do projecto final, expbe 0s seus objectivos,
analisa a sua historia e influéncias relativamente ao proprio tema, cenario, personagem e

descreve a pesquisa efectuada para a pré-producdo do projecto;

- no capitulo 3 faz-se uma revisdo do Estado da Arte, discorrendo sobre a histéria do CGI
e apresentando o perfil de alguns autores relevantes da area da modelacdo de rostos humanos
realistas; segue-se um guido completo para a concepgdo do modelo de uma cabe¢ca humana
realista, com a utilizagdo dos softwares Maya e ZBrush;

- 0 capitulo 4 dedica-se completamente ao desenvolvimento do projecto final, desde a pré
a p6s-producao;

- 0 capitulo 5 €é designado a conclusdes relativas a todos os capitulos anteriores e ao
processo de desenvolvimento do projecto final, reservando um espago para a reflexdo quanto

a perspectivas de trabalho futuro.
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2 Caracterizacdo do Projecto

Neste capitulo, expdem-se 0s objectivos do projecto final, analisando a sua histéria e o
modo como se alcancou a sua versao final, os filmes e videojogos que inspiraram e
influenciaram factores como o tema e a personagem, fazendo ainda uma descricdo da

pesquisa efectuada para a sua pré-producéo.

2.1 Descricéo e Objectivos

The Night Shift € uma curta-metragem de animacéo integralmente em 3D, com cerca de
dois minutos e meio de duracéo, concebida com recurso a softwares soberanos da indudstria do
cinema de animacédo e dos efeitos visuais criados por computador, como Autodesk Maya,
Pixologic ZBrush, Adobe Photoshop e Adobe After Effects.

A sua representacdo realista prende-se com os interesses e ambi¢des que moveram o
desenvolvimento deste projecto individual, partindo da influéncia dos excertos
cinematogréaficos dos videojogos, em que as personagens sdo apresentadas em alta resolucéo,
deslumbrando o espectador/jogador. O género de ficcdo cientifica desempenha também um
papel importante neste projecto, ndo s6 no respeitante ao tema, como também a iluminacao do

cenario, o tipo de filmagem e actuacdo das personagens.

Fig. 2.1 — Imagem retirada de The Night Shift

O principal e indiscutivel objectivo deste projecto é demonstrar competéncias,
principalmente no campo da realizacdo, modelacdo e animacdo, de modo a enriquecer o
portfolio, na esperanca de que este seja 0 mais favoravel possivel a obtencdo de um cargo
profissional desejado. Como tal, procurou-se desenvolver uma histéria que contivesse a sua

dose de ac¢édo, de modo a forcar essas capacidades a serem postas em pratica.
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A par do projecto, foi realizada a presente Dissertagdo com o tema Modelagdo do Rosto
Humano Realista, com o intuito de consolidar os conhecimentos de modelacdo até a altura
adquiridos. Num momento em que a indecisdo entre modelacdo e animacdo se mantinha
quanto ao futuro profissional, a opcdo por uma Dissertacdo sobre modelacdo acabou por
ganhar forma. O facto de o projecto e a propria Dissertacdo se basearem na forma humana
esta directamente ligada ao facto de, na altura de contratar, as empresas darem bastante mais
valor e prioridade aos artistas que dominam a modelacdo da forma humana do que aos que
apenas mostram modelos de qualquer tipo de criaturas imagindrias. Isto porque quem domina
a anatomia humana tem as bases fundamentais para saber modelar tudo o resto. “Anatomy is
the structural foundation that grounds characters in the physical world and makes them
believable, even if they are cartoons or imaginary creatures”. “Given that a creature is
situated in a world with physics similar to our own, it will have evolved similar mechanisms
for dealing with gravity, mass and momentum. Use your knowledge of human anatomy to
imagine how the creature might be constructed with muscles and bones so that it can react to
the environment around it” (Eaton, 2006: 52/55).

2.2 A Historia

The Night Shift relata uma ocorréncia durante a patrulha nocturna de Christopher Cole e
Daniel Smith num sitio em que nunca haviam estado, um hospital psiquiatrico antigo e
aparentemente abandonado. O som de uma porta a abrir leva Cole a suspeitar que ha alguém
ndo autorizado no local e a averiguar a situacdo, o que o0 leva a uma sala repleta de
incubadoras e computadores. Dentro de cada incubadora, um corpo humano permanece
imovel, aparentemente induzido em sono profundo. Cole deambula entre as incubadoras,
procurando o causador do ruido, até que repara que uma das incubadoras se encontra vazia e
de porta aberta. Sem ter tempo de raciocinar, apercebe-se de que alguém o observa, e desvia-
se de um tiro destinado a si. Inicia-se uma perseguicdo ao longo do corredor do hospital, que
termina nos lavabos: Cole procura o infractor nas trés cabines privativas, sem sucesso,
acabando por ser surpreendido e atingido com um tiro no peito, pelo infractor, que se tinha
escondido atras da porta de entrada dos lavabos e acaba por revelar ao espectador que é um

clone do proprio Cole e que, provavelmente, ird agora assumir o seu lugar.
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2.3 Influéncias

Como foi referido antes, no que toca ao aspecto visual, este projecto foi vastamente
influenciado pela linguagem cinematografica de determinados videojogos e seu aspecto

realista, como é o caso de Dragon Age (Electronic Arts, 2009) e Prototype (Activision, 2009).

O tema do projecto foi inspirado no género de ficcdo cientifica, em filmes como Blade
Runner (1982), de Ridley Scott, The Island (2005), de Michael Bay, e Pandorum (2009), de
Christian Alvart, de onde foram retirados elementos relacionados com clonagem e

perseguicao.

Os jogos Silent Hill (Konami), Batman: Arkham Asylum (Eidos Interactive, 2009) e
Splinter Cell: Conviction (Ubisoft, 2010) influenciaram no respeitante ao cenario e ambiente,
assim como os filmes Tron: Legacy (2010), de Joseph Kosinski, Resident Evil: Afterlife
(2010), de Paul W. S. Anderson e Shutter Island (2010), de Martin Scorsese.

A aparéncia fisica da personagem foi extensamente baseada no actor Jason Statham.

—

Fig. 2.2 — Jason Statham Fig. 2.3 — Christopher Cole

O seu estilo e personalidade estdo também relacionados com ele, uma vez que sdo, em
parte, inspirados em Frank Martin, a personagem que o actor desempenha na sequéncia
Transporter (2002, 2005 — Louis Leterrier e Corey Yuen — e 2008 — Olivier Megaton). No
entanto, diversas personagens de videojogos emprestaram também a sua personalidade e
modus operandi a Christopher Cole, como é o caso de Sam Fisher, da saga Splinter Cell
(Ubisoft), Max Payne, do jogo homénimo (Rockstar Games, 2001), Edward Carnby da série
Alone In The Dark (Infogrames; Atari), Chris Redfield de Resident Evil 5 (Capcom, 2009) e
John Shepard, da saga Mass Effect (Electronic Arts, 2009 — 2011).



Modelacdo do Rosto Humano Realista

2.4 Pesquisa Efectuada para a Pré-Producéo do Projecto

Aliando o util ao agradavel, a pesquisa para a pré-producdo do projecto consistiu
largamente na visualizacdo de filmes com o actor Jason Statham como protagonista, de forma
a poder assimilar as suas feicOes e expressoes faciais. Foram igualmente revisitados filmes ja
anteriormente vistos, do genero de ficgdo cientifica, procurando estudar-se o tipo de
iluminacdo e filmagem. Constou também da recolha de filmagens, fotografias e imagens, e da
experimentacao dos videojogos tomados como referéncia, de modo a analisar principalmente

0S movimentos das personagens e 0s cenarios.

Procurou-se ainda consolidar conhecimentos na area da modelagdo e da animacao,
através da leitura de livros e revistas, assim como da visualizagdo de tutoriais online ou em
DVD dedicados ao tema.

Antevendo a necessidade de aplicar cabelo a personagem, e querendo obter resultados
superiores aos anteriormente obtidos através do Maya Fur, funcdo integrada no Maya
existente para o efeito, fez-se também uma pesquisa relativamente a alternativas, tendo levado
ao estudo e experimentacdo do aplicativo Shave and a Haircut para o0 Maya, embora, no final,
devido a problemas técnicos, se tenha recorrido a mera texturizacao para dar ilusdo de cabelo

e barba.

Foi também necessario o estudo do The Setup Machine, um aplicativo para 0 Maya que
permite facilmente criar o rig para qualquer tipo de personagem, seja ela um humano, um
animal ou qualquer outra criatura imaginaria, assim como se analisou e experimentou o The
Face Machine, aplicativo destinado a criacdo do rig facial, que acabou por se tornar inviavel e

levar a um outro processo menos directo.

2.5 Conclusdo de Capitulo

O projecto final resulta de uma combinacdo de gostos pessoais e ambicdes do autor,
sendo sustentado por diversas referéncias e vastamente influenciado por linguagens inerentes

aos videojogos e a ficcédo cientifica.

Tratando-se de um projecto individual, The Night Shift é uma oportunidade para a
criagdo de um portfolio preenchido de acordo com os interesses do autor, a0 mesmo tempo

que permite o desenvolvimento das competéncias até entdo adquiridas.
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3 Revisdo do Estado da Arte

Neste capitulo, € abordado o tema da producdo de efeitos visuais gerados por
computador, fazendo-se um pequeno estudo relativo a sua historia, evolucdo ao longo dos
anos, e aplicacdo a outras areas para além do cinema. Seguir-se-a um guido completo para a
criagdo de uma cabega humana realista, por meio dos softwares Maya e ZBrush, obedecendo

as normas topoldgicas para um bom funcionamento numa animacao.

3.1 Definicdo e historia do CGlI

CGI é a abreviatura para Computer-Generated Imagery ou, em portugués, Imagens
Geradas por Computador, e trata-se da utilizacdo de graficos computadorizados
tridimensionais nos efeitos especiais de filmes, animacdes, séries televisivas, anuncios

publicitarios, entre outros.

O CGI é utilizado na industria dos efeitos visuais devido ao facto de os efeitos gerados
por computador terem mais qualidade e serem mais féaceis de controlar do que outros
processos mais fisicos, como a construcdo de miniaturas, além de permitirem a criacdo de
imagens que ndo seriam realizaveis utilizando qualquer outra tecnologia. Possibilita, ainda, a
concepcdo de imagens sem a necessidade de se recorrer a utilizagdo de actores, aderegos ou

cenarios reais.

A primeira vez que o cinema recorreu ao CGI foi em 1973, através da utilizacdo de
imagens computadorizadas bidimensionais digitalizadas, no filme Westworld, uma obra de
ficcdo cientifica de Michael Crichton, sobre um parque tematico populado por robds
concebidos para entreter os humanos. Os gréficos tridimensionais foram usados pela primeira
vez trés anos mais tarde, na sua sequela Futureworld, de Richard T. Heffron, onde um rosto e

uma mao sdo gerados por computador.

=

Fig. 3.1 - Imagens retiradas do filme Futureworld, o primeiro filme em que se recorreu ao uso de gréaficos tridimensionais.


http://en.wikipedia.org/wiki/Michael_Crichton
http://en.wikipedia.org/wiki/Richard_T._Heffron

Modelagéo do Rosto Humano Realista

Na lista de filmes a utilizar o CGI seguiu-se, em 1977, o primeiro da saga Star Wars, de
George Lucas, a0 mostrar a estrutura tridimensional da estagdo espacial Death Star e os
computadores de bordo das naves espaciais. (O anexo A apresenta uma tabela cronolégica dos
eventos do CGIl mencionados neste capitulo). Em 1978, o filme Superman, de Richard
Donner, apresenta o primeiro genérico em CGI e, em 1979, Alien, de Ridley Scott, utiliza

também o CGI nos monitores dos computadores de bordo da nave espacial.

Fig. 3.3 - Imagem do genérico do filme Superman Fig. 3.4 - Imagem do filme Alien

Mas s6 alguns anos depois é que surgiram os dois primeiros filmes a investir fortemente
no CGI tridimensional: Tron (1982), de Steven Lisberger, utilizou-o extensivamente,
inclusivamente na sequéncia da corrida de lightcycles, e The Last Starfighter (1984), realizado
por Nick Castle, em que todas as naves sdo geradas por computador, substituindo os modelos
tradicionais (The Last Starfighter € o primeiro caso de utilizacdo de CGI em que os efeitos sdo
concebidos para representarem objectos reais). No entanto, ambos foram fracassos

comerciais, facto que levou a maioria dos realizadores de cinema a pér de lado o CGI.

Fig. 3.5 - Imagem do filme Tron, na sequéncia da corrida de Fig. 3.6 - Imagem do filme The Last Starfighter,
lightcycles mostrando naves espaciais geradas por computador

| friee i
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Por outro lado, no campo do cinema de animagéo, a Pixar comecou a sua producdo em
1986 com Luxo Jr., a segunda curta-metragem de sempre a ser gerada por computador e a
primeira a ser nomeada para o Oscar de Melhor Curta-Metragem de Animacdo. Em 1988,

conquistou mesmo esse Oscar, com Tin Toy.

¢ X A R

ANIMATION STUDIOS

Fig. 3.7 — A esquerda, imagem retirada da curta-metragem Luxo Jr. Em sua homenagem, todos os filmes produzidos pela Pixar sdo
precedidos de uma pequena animagéo da personagem, na apresentacao do logétipo da empresa.

Jaem 1991, os filmes Terminator 2: Judgment Day, de James Cameron, e Beauty and the
Beast, da Disney, revolucionaram a industria cinematogréfica, gracas a utilizacdo do CGlI
perfeitamente integrado nas suas cenas, marcando a transi¢cdo da animagdo tradicional e dos
efeitos visuais convencionais para técnicas digitais. Terminator 2 venceu o Oscar de Melhores
Efeitos Visuais, gracas a primeira utilizacdo do movimento humano natural numa personagem
virtual e a primeira personagem principal parcialmente gerada por computador, enquanto
Beauty and the Beast — em que as personagens Bela e Monstro, animadas do modo
tradicional, foram combinadas com um cenério de graficos tridimensionais — foi a primeira

longa-metragem de animac&o a ser nomeada para o Oscar de Melhor Filme.

y .
- B

Fig. 3.9 — Imagem retirada da cena de danca em Beauty and the Beast.

Fig. 3.8 — Imagens retiradas do filme Terminator 2.


http://en.wikipedia.org/wiki/James_Cameron
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Outros casos em que se utilizou fortemente a integracdo de CGI em filmes sdo Jurassic
Park, realizado por Steven Spielberg em 1993, e Forrest Gump (1994), realizado por Robert
Zemeckis. Em Jurassic Park, modelos fotorrealistas* de dinossauros criados em computador
foram integrados em reproducdes de dinossauros a escala real, controlados hidraulicamente e
filmados no cenério (animatronics). Em Forrest Gump, Tom Hanks foi inserido em diversas

filmagens antigas, mas o exemplo mais notavel é a remocéo digital das pernas do actor Gary

Sinise. O CGI comecava a conhecer cada vez mais possibilidades de utilizacao.

Fig. 3.10 - Imagens retiradas do filme Forrest Gump,
demonstrando exemplos da utilizagéo dos efeitos criados por
computador. Na imagem de baixo (a esquerda), Tom Hanks

“contracena” com John Lennon.

Na televisdo, Babylon 5, de J. Michael Straczynski e SeaQuest, criada por Rockne S.
O'Bannon foram, em 1993, as primeiras séries a usar o CGl como método principal para os
seus efeitos visuais, marcando a estreia televisiva na utilizacdo de cenéarios virtuais. No ano
seguinte, Insektors, realizada por Georges LaCroix, foi a primeira série de televisdo
completamente animada por computador, seguindo-se-lhe, no mesmo ano, a famosa série

ReBoot, criada por Gavin Blair.

Em 1995, a Disney-Pixar lancou Toy Story, a primeira longa-metragem completamente
gerada por computador. O seu sucesso comercial foi tremendo, gerando receitas astronémicas
e excelentes criticas. Roger Ebert, colunista do Chicago Sun-Times, reconhecido pela Forbes
como 0 comentarista mais poderoso da Ameérica, comparou a animacdo inovadora de Toy
Story ao filme Who Framed Roger Rabbit, dizendo que “Ambos os filmes desmantelam o
universo do visual cinematografico e compdem-no novamente, permitindo-nos ver de um
novo modo” (Ebert, 2007:784).

! Fotorrealismo é o termo gue denomina um movimento artistico originario nos Estados Unidos no final dos anos 60, constituindo um género
de pintura que retrata muito realisticamente a informacéo captada previamente por uma fotografia.
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Fig. 3.11 - Imagem retirada do filme Toy Story

No inicio deste milénio, o CGI tornou-se a forma dominante de producdo de efeitos
especiais. A tecnologia progrediu ao ponto de se tornar possivel a criacdo de duplos virtuais,
facilitando inclusivamente na realizacdo de cenas de multidGes, o que praticamente torna
obsoleta a contratacdo de pessoal adicional. A trilogia de The Lord of the Rings (2001-2003),
realizada por Peter Jackson, contém vérias batalhas em larga escala concebidas por CGl,
incluindo cem mil guerreiros gerados por computador na batalha do prélogo de The Lord of
the Rings: The Fellowship of The Ring (2001). A maior e mais digna de nota € a batalha
debaixo de chuva torrencial em The Lord of the Rings: The Two Towers (2002). Em Matrix
Reloaded (2003), realizado pelos irm&os Andrew e Laurence Wachowski, hd uma cena de luta
em que surgem cem Agentes Smith (personagem interpretada pelo actor Hugo Weaving) por
obra das técnicas de efeitos especiais; as accOes do verdadeiro Agente Smith foram gravadas

e, posteriormente, reproduzidas de diferentes angulos.

Fig. 3.12 - Imagens retiradas dos filmes The Lord of the Rings: The Two Towers e
Matrix Reloaded respectivamente, demonstrando a criacéo de multiddes através do CGI
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O grande desafio permanece a concepgdo de um filme de animacdo de humanos
fotorrealistas. Até a data, o cinema de animacgdo conta as historias de personagens que
representam animais (lce Age [2002], Finding Nemo [2003]), maquinas (Cars [2006], Wall-E
[2008]), criaturas oriundas do imaginario (Shrek [2001], Monsters Inc. [2001]) ou até
humanos em forma de cartoon (The Incredibles [2004], Up [2009]).

O filme de 2001 Final Fantasy: The Spirits Within, de Hironobu Sakaguchi, é
frequentemente considerado o primeiro esfor¢co na tentativa de mostrar humanos realistas
gerados por computador, seguido de outros como The Polar Express (2004), e Beowulf
(2007), ambos realizados por Robert Zemeckis, em que os actores, apesar de serem criados
digitalmente, sdo facilmente reconheciveis. Todavia, estas tentativas tém sido alvo de criticas;
a enorme complexidade do corpo humano e a sua biomecanica tornam muito problematica a
simulacdo realista de humanos. Além disso, observar algo que parece e se move quase como
um humano desperta um sentimento de repulsa e desconforto psicoldgico no espectador, o
que remete para a teoria do uncanny valley (vale estranho). Esta teoria foi criada em 1970
pelo roboticista Masahiro Mori para explicar a resposta emocional de um ser humano perante
um robd (Fig. 3.12); a medida que o rob6 € cada vez mais parecido, em aparéncia e em
movimento, a um ser humano, a reac¢cdo humana é cada vez mais positiva e empatica, até que
chega a um ponto em que, rapidamente, passa a ser de repulsa. Porém, a medida que a
aparéncia € movimento do robd continuam a tornar-se menos distinguiveis dos de um ser
humano, a resposta emocional torna-se novamente positiva e aproxima-se dos niveis de
empatia de uma relagcdo de humano para humano.
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Fig. 3.13 - Gréfico representativo da teoria do uncanny valley, criada a respeito de robds, mas perfeitamente aplicavel a animagéo
por computador; a depresséo no gréfico — o tal “vale estranho” - representa a reac¢do emocional negativa do ser humano em relagéo a

robds que quase parecem humanos. Quando providos de movimento, a reaccdo emocional é amplificada.

14


http://en.wikipedia.org/wiki/Hironobu_Sakaguchi
http://www.google.pt/url?q=http://www.imdb.com/name/nm0000709/&sa=X&ei=lWrcTOOMAc61hAfihdHPAg&ved=0CDsQggkoADAB&usg=AFQjCNF_iuJxdTbBoJ9fgpjsD09NwJEJ2A

Modelagéo do Rosto Humano Realista

No entanto, o facto de, em menos de 20 anos, a inddstria da criacdo digital ter evoluido
do jogo Pac-Man, desenvolvido pela Namco em 1980, para o filme Beowulf deixa acreditar

que ndo tardara muito para que se torne dificil distinguir entre actores reais e digitais.

Fig. 3.14 - O jogo Pac-Man ao lado de Angelina Jolie gerada por computador, no filme Beowulf

A industria dos videojogos tem apostado cada vez mais no aspecto fotorrealista, a par da
continua evolugdo das plataformas, embora tenha sempre o cuidado de usar baixas resolucdes,
de modo a que o computador possa gerar as imagens em tempo real, tornando assim possivel
a jogabilidade. Os graficos que utilizam raramente sdo considerados como CGI, mas muitas
vezes lancam videos de apresentacdo ou incluem excertos cinematograficos e filmes
introdutérios que constituem tipicas aplicacdes de CGI, em que a modelacdo e animagéo sao
criadas tdo fotorrealisticamente quanto possivel, dado que as imagens sdo geradas
previamente. Exemplo disso € o jogo Dragon Age: Origins, publicado pela Electronic Arts, ou

Prototype, publicado pela Activision, ambos em 2009.

Fig. 3.15 — Excertos dos videos de apresentacéo do jogo Dragon Age: Origins
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Desde a sua origem, e gracas ao seu rapido desenvolvimento, o CGI tem sido
abundantemente utilizado num vasto leque de industrias para além das do entretenimento,
oferecendo novas hipoOteses de emprego a animadores com experiéncia na inddstria
cinematogréafica. As possibilidades de aplicacdo do CGI tém sido cada vez mais exploradas
em areas como a arquitectura, engenharia e medicina, pois a sua capacidade de simular a
realidade torna-o extraordinariamente Util na modelacdo de edificios, pegas industriais e
Orgdos humanos internos, entre outras conveniéncias. Um exemplo disso € a invencdo de uma
mesa de autdpsias virtuais desenvolvida por investigadores suecos, através da utilizacdo de
ciéncia e tecnologia que € utilizada na investigacdo criminal para complementar as autopsias
reais. Esta invencdo permite ao examinador a observacdo do corpo em detalhe microscépico,
depois do processo de digitalizacdo de menos de 20 segundos de duracdo, permitindo-lhe
aproximar ou afastar a imagem, interagir com o corpo através de um bisturi virtual, sem

comprometer a integridade do corpo real.

Fig. 3.16 — O CGI ao servigo da medicina

A SIGGRAPH!, uma conferéncia anual convocada em diferentes cidades dos Estados
Unidos da América dedicada aos graficos computadorizados e técnicas interactivas, mostra
todos os anos os desenvolvimentos alcangados nas tecnologias do CGI a dezenas de milhares

de profissionais que marcam comparéncia.

! SIGGRAPH ¢ 0 acrénimo para Special Interest Group on GRAPHics and Interactive Techniques

16



Modelagéo do Rosto Humano Realista

3.2 A Modelacéo de um Rosto Humano Realista

Depois de uma sumaéria apresentacdo de alguns artistas relevantes da area em estudo, far-
se-a entdo a introducdo ao software Maya, com uma breve abordagem as principais
ferramentas e técnicas de modelacdo. Posteriormente, enunciar-se-4 0 método de modelagéo
da cabeca e de cada um dos elementos que constituem o rosto humano, a medida que o
modelo do Projecto Final vai sendo concebido (note-se que o modelo do Projecto Final sera
integralmente modelado em poligonos, pelo que ndo serdo abordados outros metodos de
modelacdo). De seguida, 0 modelo transitara para o software ZBrush, da Pixologic, onde se

elevard o nivel de realismo do rosto de um modo mais comparavel ao da escultura tradicional.

3.2.1 Artistas Relevantes

Os artistas apresentados neste capitulo trabalham na inddstria dos efeitos visuais, em
areas directamente relacionadas com o tema da Dissertacdo. Colaboraram na producgdo de
filmes ou videojogos mundialmente reconhecidos, contando ja com um portfolio recheado de
obras de modelacdo digital admiraveis. S&o membros activos da comunidade online de artistas
digitais, alguns sdo instrutores de workshops ou cursos adquiriveis através da compra online,
integrando inclusivamente a equipa de testes de varios softwares de modelacdo. Por estas

razfes, a sua mencdo foi considerada indispensavel.

Cesar Dacol Jr.* trabalha na indUstria cinematografica ha perto de
20 anos, tendo iniciado a sua carreira na industria dos efeitos de
maquilhagem e transitado para os efeitos por computador a meio dos

anos 90. Com um historico em anatomia e escultura tradicional,

rapidamente se adaptou ao mundo 3D dos computadores.

Fig. 3.17 — Cesar Dacol Jr.

Entre 2003 e 2004, trabalhou como Modelador de Personagens e Director Técnico para o
filme de animacdo The Wild (2006), realizado por Steve “Spaz” Williams. Foi responsavel

pela criacdo das esculturas digitais das personagens e respectivos esqueletos para animacao.

Fig. 3.18 — Personagem modelada por Cesar Dacol Jr. em The Wild

1
Informagdo retirada do perfil de instrutor online: http://workshops.cgsociety.org/instructors/Cesar_Dacol_Jr/
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No final de 2004, Cesar foi nomeado Professor Adjunto de Modelagdo de Personagens
Poligonais Avancadas no Sheridan College em Ontério, Canad4, do curso de Animacdo por

Computador.

Em 2005, foi responsavel pela criacdo de diversos aderecos para o filme de animacéo
Barnyard (2006), de Steve Oedekerk, e pela criacdo de veiculos digitais de alta resolucdo para
o filme Fantastic Four (2005), realizado por Tim Story. Entre 2005 e 2007, Cesar foi o
Supervisor de Modelacdo na Meteor Studios, onde orientou a criagdo de ambientes e de
personagens digitais para filmes como 300 (2006), de Zack Snyder, e Journey To The Center
of The Earth (2008), realizado por Eric Brevig. Posteriormente, orientou a criacdo de

personagens digitais e animacéo facial para o filme Foodfight! (2009), de Lawrence Kasanoff.

Fig. 3.19 — Personagem do filme 300 criada digitalmente (a esquerda), ao lado de um actor real (a direita)

Para além da sua contribui¢cdo no cinema, Cesar também colaborou em projectos de
outras areas, como 0s videojogos, eventos musicais e anuncios publicitarios, nos quais teve
igualmente o papel de modelador de personagens digitais e respectivas expressoes faciais. Na
area dos videojogos, destaca-se o video introdutério do jogo Rockband 2 (MTV Games,
2008), em que Cesar trabalhou de perto com um cantor/actor que cedeu as suas expressoes

faciais a personagem.

Fig. 3.20 — Imagem do video introdutério de Rockband 2, Fig. 3.21 — Actor empresta as suas expressdes faciais a personagem do video
mostrando o rosto de um modelo trabalhado por Cesar introdutério de Rockband 2
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No que diz respeito a eventos musicais, Cesar trabalhou para uma adaptacdo musical do
romance de ficcdo cientifica War Of The Worlds de 1898, de H. G. Wells. Para esta
adaptacdo, Cesar recriou digitalmente o rosto do ja entdo falecido actor Richard Burton, que

posteriormente surgiria projectado a proferir a narragdo previamente gravada.

No campo dos anuncios publicitarios, Cesar concebeu um rosto digital que serviria de

porta-voz para a companhia de telecomunicacdes holandesa Dutch Telecom.

Fig. 3.22 — Rosto digital de Richard Burton Fig. 3.23 — Rosto digital para a Dutch Telecom

Actualmente, trabalha como modelador na Dr. D Studios, possuindo a sua prépria
empresa de efeitos especiais, Voodoo Monkey Co. Cesar é também instrutor de escultura de
personagens digitais nos CGWorkshops da CGSociety' e na The Gnomon Workshop?, assim

como um membro da equipa de testes do software ZBrush da Pixologic.

Fig. 3.24 — “Norman” foi criado no periodo de testes do ZBrush 2.5. Tornou-se Fig. 3.25 — Escultura digital concebida por Cesar na
uma espécie de celebridade, sendo possivelmente a mais reconhecida obra de criagdo de um dos DVDs de instrucéo para a Ghomon
Cesar Dacol Jr. Workshop, onde o artista ensina a esculpir rugas

CGSociety é a organizacdo global mais respeitada e acessivel aos artistas digitais, dando-lhes apoio em todos os niveis e oferecendo um
leque de servigos para criar contactos, informar, educar e estimular a exceléncia e inovacdo em todos os aspectos da arte digital.

2 The Gnomon Workshop é a corporagdo irma da The Gnomon School of Visual Effects, que proporciona, a estudantes e profissionais,
instrucdo em efeitos especiais de calibre profissional, em Los Angeles, na Califérnia.
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lan Joyner' é um artista freelancer americano, especializado em [ M\ e |
modelacdo de personagens, escultura digital, texturizacdo e design. f
! = &
-

Trabalhou em jogos de nova geracdo, filmes de cinema e

o~

|

prototipagem rapida.

Comecou a sua carreira profissional em 1999, como designer g <4 - n
gréafico, responsavel por programacdo de websites, criacdo de Fig. 3.26 — lan Joyner
logotipos, design de cartdes-de-visita e ilustracdo de t-shirts. Depressa se aborreceu; 0s seus
gostos pessoais sempre haviam sido a escultura, a banda desenhada e o cinema, tudo o que
tivesse relagdo com personagens, algo que ndo conseguia encontrar neste tipo de projectos.
Acabou por abandonar 0 seu emprego seguro e ingressar num contrato trimestral na iThink
Studios, empresa pertencente a um amigo, onde estabeleceu contacto com o 3D pela primeira
vez e acabou por permanecer durante mais algum tempo. Entusiasmado por esta forma de
arte, comecou a participar nos féruns online relativos ao tema e a assistir durante horas

interminaveis a DVDs da Gnomon Workshop.

Entre 2002 e 2004, em regime freelance, criou personagens para videos cinematicos de
videojogos, entre outros pequenos trabalhos para a industria do cinema e da publicidade
televisiva, para clientes como a Sony e os estudios de animacdo Icepond e Blur. O seu tempo
livre era dedicado a participacdo em concursos online, tendo vencido um CG Challenge.

www.ianjoyner.

Fig. 3.27 — Modelos criados por lan Joyner para projectos da Blur

Em 2004, ingressou no estudio Blur, onde colaborou, durante quatro anos, em todo o tipo
de projectos, como filmes de cinema e videos cinematicos para videojogos aclamados pela
critica, tornando realidade o seu sonho de crianga de poder viver da criacdo de monstros e
super herois. lan foi responsavel pela modelacéo e texturizagcdo de personagens de todo o tipo,
desde animais cartoon a seres demoniacos, além de ter colaborado no controlo de qualidade

de todos os aspectos relacionados com personagens.

! Informagcdo retirada do perfil LinkedIn do artista: http://www.linkedin.com/pub/ian-joyner
e da sua pagina pessoal: http://www.ianjoyner.com/about.html
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Os projectos incluiram o filme Rocky Balboa (2006), de Sylvester Stallone, e 0s

videojogos Marvel Ultimate Alliance (2006, Activision), Rise of Legends (2006, Microsoft),
The Outfit (2006, THQ), Bioshock (2007, 2k Games), Hellgate: London (2007, Flagship
Studios), Warhammer (2008, EA) e Halo Wars (2009, Microsoft), assim como a curta-

metragem de animagéo A Gentlemen’s Duel (2006, Blur Studio), entre muitos outros.

Fig. 3.28 — Modelo de Rocky Balboa Fig. 3.29 — Ogre em Warhammer Fig. 3.30 — Collossus, em Marvel Ultimate Alliance

Fig. 3.31 — Modelos do jogo The Outfit Fig. 3.32 — Modelo para Gentlemen’s Duel

No ano de 2007, ensinou, durante 4 meses, modelagdo com poligonos na Gnomon School
of Visual Effects. As matérias abordadas incluiam modelacdo de superficies rigidas e

modelacdo organica basica.
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Desde 2006, criou dois DVDs para a Gnomon Workshop, onde expde a sua metodologia
relativamente a criacdo de personagens. O primeiro cobre a fase de modelacdo, o segundo o

processo de texturizacao.

Fig. 3.33 — Personagem desenvolvida ao longo dos dois DVDs da Gnomon Workshop

lan participou também na equipa de testes de varios softwares, como o Mudbox,
Softimage XSI e ZBrush 2 e 3.

Em Janeiro de 2009 ingressou no estudio Legacy FX, onde se encontra empregado desde
entdo, tendo colaborado no filme Iron Man 1l (Jon Favreau, 2010) e noutros projectos ainda

por revelar. Continua, no entanto, a aceitar propostas de trabalho em regime freelance.

Fig. 3.34 — Personagens modeladas e texturizadas por lan Joyner, para Hellgate: London, Rise of Legends e Bioshock respectivamente
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Jelmer Boskma® nasceu e cresceu no norte da Holanda, numa
familia inspirada para as artes. A paixao do seu pai por programacao
ajudou-o inadvertidamente a encontrar a escolha para a sua carreira.
Um computador na casa levou a uma exposi¢éo prematura a internet

e ao primeiro emprego em web design aos 13 anos de idade. Pouco

tempo depois, a conexdo entre os graficos 3D na Web e o trabalho  Fig. 3.35 - Jelmer Boskma
artistico nos jogos foi estabelecida, e Jelmer deu consigo a criar

aderecos para titulos como Unreal Tournament. O seu passatempo de transformar as suas
personagens despertou a atengdo da produtora de jogos Digital Extremes, levando-o ao seu
primeiro emprego na area do 3D aos 18 anos. Nesse momento, Jelmer apercebeu-se da sua

verdadeira vocagdo e comecou a procurar instrucdo formal na area do 3D.

Fig. 3.36 — Retrato 3D do actor Johnny Depp

Depois de muita pesquisa, Jelmer escolheu a Vancouver Film School, no Canada. Ndo
era um pequeno passo a dar, para alguém que ainda ndo tinha vinte anos de idade, de repente
partir para o outro lado do mundo, perseguindo um sonho. Houve momentos de hesitacdo, em
que Jelmer ndo sabia se havia de se tornar um modelador de personagens ou animador, mas
todas as duvidas foram desfeitas ao fim de algumas semanas no Canada. Pouco depois da
entrega do seu segundo trabalho escolar, o instrutor de Jelmer revelou-lhe o quéo talentoso o

considerava, aconselhando-o a seguir o ramo de modelacao.

Fig. 3.37 — “Tom, the Friendly Troll”

! Informacdo retirada do website pessoal do artista: http://www.jelmerboskma.com/
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Fig. 3.38 — Retrato 3D do musico Keith Richards

O seu demo reel* final foi destacado proeminentemente em diversos féruns online.
Dentro de escassos meses de se ter formado, Jelmer estava j& na Frantic Films, na singular
posicdo de poder criar 0 design, modelar e texturizar criaturas para um grande langcamento de
Hollywood, Journey To The Centre of The Earth. Para um recém-formado, este tipo de
oportunidade é praticamente utopico. Desde entdo, Jelmer tem trabalhado numa quantidade de
grandes langamentos que inclui District 9 (Neill Blomkamp, 2009), Watchmen (Zack Snyder,
2009) e G.I. Joe: The Rise of Cobra (Stephen Sommers, 2009), entre outros.

Fig. 3.39 — Duplos digitais dos actores de G.I. Joe Fig. 3.40 — Modelo para Journey to the Centre of the Earth

Recentemente, concluiu trabalho no filme Sucker Punch (2011), realizado por Zack
Snyder e expandiu o seu repertério, incluindo matte painting no langamento da Disney, Tron
Legacy (2010, Joseph Kosinski).

Actualmente, a caminho dos seus 25 anos de idade, Jelmer estd sob contrato com a
Digital Domain, a trabalhar no filme da Marvel, Thor (2011, Kenneth Branagh).

Demo reel é o video equivalente ao portfolio de um artista. E tipicamente utilizado como uma ferramenta para promover o talento do artista
e a sua experiéncia em determinada area, neste caso nos efeitos visuais


http://www.imdb.com/name/nm0088955/
http://www.google.pt/url?url=http://www.imdb.com/name/nm2676052/&rct=j&sa=X&ei=CzguTcPVHcO_4ga4mOyCCw&ved=0CB8QggkoADAA&q=tron+2011+imdb&usg=AFQjCNG1PlVx9JTp9GPOPlfs-gvFfsTIoA&cad=rja
http://www.google.pt/url?url=http://www.imdb.com/name/nm0000110/&rct=j&sa=X&ei=vTguTbClG8Pd4AaOtLTLCw&ved=0CCgQggkoADAA&q=thor+imdb&usg=AFQjCNH-TRXnXJu7Fz0NbxMnvOC7zxH6kw
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Os trés artistas mencionados constituem alguns dos variados exemplos de sucesso na
indUstria dos efeitos visuais para o cinema, sendo fonte de inspiracdo e dando motivo para
acreditar que o ambicionado grande sucesso profissional ndo € de todo uma impossibilidade,
se houver principalmente perseveranca, dedicacédo e talento a serem postos em pratica e dados

a conhecer ao mundo.

Todos eles provém de backgrounds muito diversos e colaboraram em projectos onde
modelaram personagens humanas, quer para videojogos, quer para filmes de grande
bilheteira, algumas tdo realistas ao ponto de o espectador ndo perceber que ndo se tratam
verdadeiramente de actores reais. Esta circunstancia cria uma aproximagéo entre o trabalho
dos artistas e o propdsito do Projecto Final e a Dissertacdo, na medida em que o primordial

objectivo € o alcance de uma carreira semelhante a dos artistas referidos.

Os DVDs que alguns dos artistas lancaram, através da Gnomon Workshop, constituiram
um auxilio extremamente valioso na fase de modelacdo e texturizacdo da personagem do
Projecto Final, assim como na complementacdo dos conhecimentos ja adquiridos e aplicados
na exposicdo da metodologia do processo de modelacdo de uma cabeca humana realista da

presente Dissertacao.

3.2.2 Apresentacédo do Software Autodesk Maya

Autodesk Maya®, baptizado com a palavra sanscrita Maya, que significa “ilusdo”, é um
programa de computador criado pela Alias System Corporation e actualmente desenvolvido
pela Autodesk, Inc, orientado para a criacdo de modelos 3D, animacdo e efeitos especiais,
bastante utilizado nas industrias do cinema e televisdo, videojogos e arquitectura.

No programa, o utilizador define um ambiente de trabalho virtual, de modo a
implementar e editar dados de um projecto em particular. A arquitectura dos elementos da
cena no Maya é node-based — a representacdo visual da cena é inteiramente baseada numa
rede de nds interligados, dependentes nas informacdes uns dos outros — pelo cada elemento

contém o seu proprio nivel de atributos.

Nas péaginas seguintes, far-se-4 uma apresentacdo dos menus do programa e das
principais ferramentas de modelagdo, acompanhada de imagens exemplificativas da sua

utilizacéo.

! Informac@o retirada do blog do programa: http://mayaautodesk.blogspot.com/
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3.2.3 As Principais Ferramentas de Modelacédo

De modo a poder seleccionar no menu a ferramenta de modelacdo que pretende usar, o

utilizador deve certificar-se que o menu set esta definido para Polygons:

'@i Autodesk Maya 2009 x64 Unlimited: untitied
File Edit Modify Create Display Window Assets Select Mesh Edit Mesh Proxy Normals Color Create UVs EditUVs Muscle Help

Fig. 3.41 — Polygons menu set

Uma outra forma de aceder ao menu € pressionando a barra de espaco. O menu que surge
no ecrd chama-se Hotbox e é considerado por muitos a forma mais rapida e eficaz de aceder

as opgdes desejadas.

Além da escolha através do menu, o utilizador podera também servir-se das shelves
(prateleiras), onde se encontram os atalhos para algumas das ferramentas.
Complementarmente, ele poderad criar a sua propria shelf, com todas as ferramentas que

pretender.

General] Culvesl Surfaces Polygons ISubdivs] Delolmationl Animationl Dynamics] Rendevingl PainkEﬂects[ Toon ] Muscle] Fluids I Fur I Hair | nCIoth] Cuslom] GoZBvushl

o099 bo00@8@ oD UPRNIAIRLRRIR AN Y THR

Fig. 3.42 — Polygons shelf

Ao lado esquerdo, encontra-se a Tool Box, que contém trés ferramentas primordiais:
Move, Rotate e Scale. Estas podem ser activadas mais intuitivamente através do teclado, com

as teclas W, E e R respectivamente.

o
S
L

Fig. 3.43 — As ferramentas Move,
Rotate e Scale na Toolbox

A maior parte dos modelos poligonais criados no Maya tém origem nos soélidos
geométricos, com maior incidéncia no cubo. Isto porque o modo mais sensato de modelar ¢é
comecando pela forma mais simples possivel e ir adicionando detalhe apenas a medida que
vamos precisando; se o adicionarmos cedo demais, torna-se muito dificil modelar mais tarde.

Este é o processo chamado box modeling.
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Antes de criarmos um cubo, vamos a Create > Polygon Primitives > Interactive Creation,
desactivando este modo, que cria 0 objecto onde clicarmos no viewport, ndo na origem.
Vamos agora a Create > Polygon Primitives > Cube. Por pré-definicdo, aparecera em
wireframe. Activemos outro modo de visualizagdo, em Shading > Smooth Shade All no menu

do viewport (atalho: tecla 5). Podemos juntar os dois modos, activando Wireframe on Shaded.

Ao pressionar o botdo direito do rato sobre o cubo, surge um menu, mostrando, entre
outras opcdes, os diferentes modos de seleccdo de um objecto através dos seus componentes.
Podemos, assim, activar o modo de selec¢do Edge (Aresta), Vertex (Vértice) e Face. Para 0s

desactivarmos, escolhemos Object Mode (Modo de Objecto).

Uma das principais ferramentas de modelacdo é a Extrude. Esta permite que arestas,
vértices ou faces sejam puxadas, criando novas sec¢bes no objecto, com origem na
componente que foi seleccionada. Para a aplicarmos numa face do nosso cubo, entramos no
modo de selecgéo de faces, seleccionamos uma delas e vamos a Edit Mesh > Extrude. Surge
um manipulador representando os trés eixos do nosso universo virtual. Clicamos num dos

eixos do manipulador e arrastamos na direc¢do pretendida.

Fig. 3.44 — Utilizagéo da ferramenta Extrude numa face do cubo

A maior parte das ferramentas possui uma caixa de opcdes a que podemos aceder, de
modo a alterarmos diversos parametros que influenciardo a forma como elas irdo actuar. Por
exemplo, a caixa de opcdes da ferramenta Extrude permite modificar, entre outros atributos, o
numero de extrusBes que serdo feitas de uma s6 vez e inclusivamente fazer uma extrusdo ao

longo de uma curva.

1 lEdit Meshl Proxy Normals Color

’ v Keep Faces Together

g Extrude E ¢
Bridge o
Append to Polygon Tool =

1
Fig. 3.45 — Acesso a caixa de opgdes da ferramenta Extrude
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De seguida, temos duas ferramentas que permitem criar edge loops (anéis de arestas em
torno do objecto). Com o0 nosso cubo seleccionado, vamos a Edit Mesh > Insert Edge Loop
Tool. Agora clicamos no botdo esquerdo e arrastamos algures sobre uma das arestas em que
pretendamos adicionar um edge loop, soltando o botdo quando a pré-visualizacao (linha verde
a tracejado) estiver no local pretendido.

Fig. 3.46 — Utilizacéo da ferramenta Insert Edge Loop

Se porventura desejarmos adicionar dois edge loops, um de cada lado do que acabamos
de criar, com o cubo seleccionado em Object Mode, vamos a Edit Mesh > Offset Edge Loop

Tool, clicamos e arrastamos sobre a aresta previamente criada.

Fig. 3.47 — Utilizacdo da ferramenta Offset Edge Loop

Podemos facilmente seleccionar um edge loop através de um duplo clique sobre uma das
arestas que o constituem, enquanto no modo de seleccdo de arestas. Se o pretendermos
arrastar, vamos a Edit Mesh > Slide Edge Tool. Pressionando o botdo do meio do rato,

arrastamo-lo até onde pretendermos e soltamos o botéo.

Fig. 3.48 — Edge loop arrastada com a ferramenta Slide Edge 28
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E possivel apagar, no s6 um objecto inteiro, como também componentes. Para eliminar
uma aresta, seleccionamo-la e premimos Delete ou Backspace. Contudo, quando desejamos
suprimir um edge loop, ao fazé-lo desta forma, o loop é de facto eliminado, mas os vértices
que faziam parte dele mantém-se no objecto. Estes vértices teriam de ser eliminados a seguir.

Existe uma ferramenta que faz isto de uma s6 vez, em Edit Mesh > Delete Edge/Vertex.

Muitas vezes precisamos de acrescentar arestas ao nosso objecto de um modo que a
insercdo de loops nao favorece. Neste caso, encontramos a solugdo em Edit Mesh > Split
Polygon Tool. Clicamos numa aresta (e arrastamos ao longo dela, se pretendido), criando o
primeiro ponto ao soltar o botdo. De seguida, clicamos numa aresta diferente, de preferéncia
complanar, criando assim uma nova aresta. Podemos continuar a criar sucessivamente novos

pontos. Quando satisfeitos, carregamos na tecla Enter, aplicando as alteracdes no objecto.

Tenhamos em mente que devemos usar sempre quad polygons (poligonos quadrilateros),
pois sdo os mais faceis de trabalhar. Se for essencial manter algum, ocultamo-lo numa zona
do modelo em que né&o haja problema caso ocorra deformagdo na animagéo ou na sua textura.

Poligonos com mais de quatro lados (n-gons) ndo podem ser usados.

Fig. 3.49 — Utilizacéo da ferramenta Split Polygon

E também possivel criar uma seccio no objecto através da projeccdo de uma linha recta
gue podemos posicionar especificamente onde e em que sentido pretendemos. Para tal, vamos
a Edit Mesh > Cut Faces Tool.

I

Click-dragg cut.

Fig. 3.50 — Utilizacdo da ferramenta Cut Faces
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Se por acaso faltasse uma das faces ao nosso cubo e precisassemos de tapar o buraco,
poderiamos proceder de duas formas. A primeira € através da seleccdo da ferramenta Append
to Polygon, também no drop menu de Edit Mesh, seleccionando de seguida duas arestas
opostas do buraco (ou seleccionando pela ordem indicada pelas setas roxas que surgem ao
seleccionar a primeira aresta). A segunda consiste em seleccionar uma das arestas do buraco e
pressionar Shift + botdo direito do rato, escolhendo Fill Hole no menu que aparece.

Fig. 3.51 — Utilizacdo da ferramenta Append to Polygon

A Ultima das principais ferramentas de modelacdo é util quando precisamos de fundir, por
exemplo, dois vértices. Seleccionamo-los, vamos a Edit Mesh > Merge e os dois Vértices

passardo a formar um so.

Fig. 3.52 — Utilizacéo da ferramenta Merge
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3.2.4 As Imagens de Referéncia

Antes de darmos inicio a um modelo, seja ele de um objecto do mundo real ou
proveniente do imaginario, convém primeiro termos estudado a sua forma, através da
observacdo do proprio objecto, de fotografias e/ou da concepcdo de esbocos. E também
importante termos a disposicdo pelo menos duas vistas dos lados mais relevantes do objecto.
No nosso caso, tratando-se de uma cabega, teremos a disposi¢édo as vista frontal e lateral. Ha
ainda quem considere bastante importante acrescentar ao desenho as linhas de construcéo,
planeando de antemdo onde serdo criados os edge loops.

Fig. 3.53 — Vistas frontal e lateral da cabeca

Criemos uma nova cena, indo a File > New Scene.

No viewport (ecrd) das vistas de frente e de lado, vamos a View > Image Plane > Import
Image, seleccionando, a seguir, o ficheiro respeitante & vista frontal e lateral da cabeca,
respectivamente. Deste modo, surgirdo em cena dois image planes (planos que contém as

imagens de referéncia).

VL8 Shading Lighting Show Renderer Panels

Select Camera

Previous View [
Next View 1
Default View

Look at Selection
Frame All
Frame Selection f

Predefined Bookmarks »
Bookmarks >

Q0
OO
00N =
XD~
“0
’W .
&

.‘
O
s

:
3§2

Camera Settings »
Camera Attribute Editor...
Camera Tools »

h
&

- ’0

Image Plane

Fig. 3.54 — Importar uma imagem de referéncia Fig. 3.55 — Vista de perspectiva, com ambos o0s
image planes ja em cena
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Por predefinigédo, os image planes sdo criados no centro do
nosso universo virtual (origem), o que perturba a modelacao.
Podemos corrigir isto se seleccionarmos cada um dos image
planes e acedermos a seccdo INPUTS na Channel Box (para
mostrar ou ocultar a Channel Box, vamos a Display > Ul
Elements > Channel Box / Layer Editor, ou entdo clicamos no
atalho indicado na Fig. 3.55). Aqui, alteramos para um valor
negativo os atributos Center X e Center Z dos image planes lateral

e frontal respectivamente.

Poderd ser necessario alinhar os dois image planes com os
eixos com mais precisdo. Para isso, basta fazer algumas

experiéncias com os valores dos atributos Center X, Y e Z.

Se quisermos ocultar os image planes na vista de perspectiva,
deixando-os visiveis apenas nas vistas que lhes competem, no
menu do viewport da vista de perspectiva vamos a Show >
Cameras. Para voltar basta

a mostra-los, repetir este

procedimento. Agora podemos comecar a modelar.

| View Shading Lighting 8,8 Renderer Panels
= P 1
: ﬂ - Isolate Select » '

All
None

NURBS Curves
NURBS Surfaces
Polygons
Subdiv Surfaces
Planes

Lights

v Joints

v IK Handles

v Deformers

v Dynamics

v Fluids

L £ X < < <

Fig. 3.58 — Ocultar os image planes

— _oe[ g
= o ;’=
H= ode ez

#

Fig. 3.56 — Atalho para
mostrar 0 Channel Box

INPUTS
imagePlanel
Frame Extension 1
Frame Offset O
Alpha Gain 1
Depth 100
Size X 1.417
SizeY 0.945
OffsetX 0
OffsetY 0
CenterX 0
CenterY 0
Center Z QI
Width 30
Height 30

Fig. 3.57 — Movendo o image
plane no eixo Z
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3.2.5 Modelagéo da Cabeca

A cabeca é, muito provavelmente, a parte do corpo mais dificil de modelar, uma vez que,
numa area reduzida, contém muitas caracteristicas marcantes. Além disso, precisa de uma
maior atencdo, dado que, ao ser animada, exige muito mais deformacéo do que qualquer outra
parte do corpo; o rosto e a cabeca precisam de se contorcer numa quase infinita quantidade de
poses e expressoes faciais. Por conseguinte, precisamos de os modelar de forma a permitir as

melhores deformaces possiveis.

Fig. 3.59 — Exemplo demonstrativo da variedade de deformagdes faciais possiveis num modelo bem executado

E extremamente importante para um modelador ter boas nogdes de anatomia; para que o
modelo seja realisticamente fiel, é conveniente ter conhecimento das estruturas muscular e
6ssea do ser humano. Usualmente, mesmo os modeladores profissionais recorrem a écorchés?,

que os auxiliam na representacéo fidedigna das massas do corpo humano.

Fig. 3.60 — Ecorché facial

1p 4 o - “« » x ;
Ecorché ¢ uma palavra francesa que significa literalmente “esfolado” e trata-se de uma representag&o em desenho, pintura ou escultura,
sem pele e gordura subcutanea para que os musculos e 0ssos do corpo humano sejam visiveis.
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Existem vérios processos para modelar uma cabega. Um dos mais utilizados e ja referido
no capitulo 3.2.3 é o box modeling que, como 0 nome anuncia, consiste em partir de uma
“caixa” (cubo), progressivamente acrescentando detalhe, maioritariamente atraves da insercédo
de edge loops, modelando-a até obter o resultado pretendido. No Projecto Final, e
naturalmente neste guido, serd desenvolvido o polygon modeling, um processo igualmente
muito utilizado, que parte de um simples poligono, crescendo a partir de extrusdes de arestas.

Fig. 3.61 — Cabeca modelada pelo processo de box modeling

O modelo da cabeca criado ao longo deste capitulo pertence ao Projecto Final, pelo que
todas as imagens exemplificativas do processo foram criadas expressamente para este guido.
De igual modo, grande parte das solu¢Ges enunciadas foi descoberta ou engendrada pelo autor
aquando da sua producéo.

Apenas precisaremos de modelar metade do rosto; mais tarde, duplica-la-emos para
formar a outra metade. Comecemos por criar uma esfera que represente o olho, apenas para
nos servir de referéncia, dando-nos uma melhor ideia de como modelar as péalpebras;
posteriormente, torna-lo-emos mais realista. Vamos entdo a Create > Polygon Primitives >
Sphere e, nos viewports da vista frontal e lateral, através das ferramentas Move e Scale,
alinhamos e escalamos a esfera em conformidade com o olho de ambos os image planes
(podera ser aconselhavel activar o modo de visdo X-Ray, em Shading > X-Ray do menu destes
dois viewports, para que possamos ver simultaneamente o image plane e o modelo). De
seguida, usamos a ferramenta Rotate para rodar a esfera de modo a ficar com o topo virado
para a frente, para facilitar os posteriores processos de texturizagdo e animagéo. Note-se que,
a medida que usamos estas trés ferramentas, os valores dos atributos Translate, Rotate e Scale
na Channel Box sdo automaticamente actualizados. Podemos também fazer alteracoes
directamente na Channel Box. Por exemplo, para nos certificarmos de que o topo da esfera
fica rigorosamente voltado para a frente, alteramos o valor de Rotate X para 90, o que
significa que a esfera far4 uma rotagdo de 90° no eixo X.

| pSpherel

Translate X 3.075

Translate Y 4.415

Translate Z 6.754
Rotate X 90
RotateY 0
Rotate Z 0
ScaleX 1.233
Scaley 1.233
ScaleZ 1.233
Visibility on

Fig. 3.62 — Esfera representando o olho. A direita, a Channel Box mostra os seus valores de Translate, Rotate e Scale 34
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Com o nosso olho a postos, podemos comecar a modelar a &rea do rosto que o envolve.
Comecgamos por seleccionar a ferramenta Create Polygon, que permitira criar o poligono que
servira de ponto de partida para o nosso modelo. Vamos entdo a Mesh > Create Polygon Tool
e, na vista frontal, criamos um poligono, clicando ponto a ponto, premindo Enter ao final do
quarto. De seguida, ajustamos os pontos, iniciando a palpebra inferior, como na Fig. 3.63.
N&o nos podemos esquecer de ir fazendo coincidir tudo também com a vista lateral.

Fig. 3.63 — Inicio da pélpebra inferior, com o uso da ferramenta Create Polygon

Vamos agora extrudir a aresta lateral do poligono para continuar a criar a palpebra

inferior, fazendo-a coincidir com o desenho, como na Fig. 3.64.

Fig. 3.64 — Continuagdo da criagdo da palpebra, através da extruséo de arestas

Continuemos a extrudir em torno do olho, criando a palpebra superior. Quando
concluido, usamos a ferramenta Merge para fundir os vértices das pontas, fechando 0s nossos

dois primeiros edge loops.

Fig. 3.65 — Fundir vértices dois a dois Fig. 3.66 — Vista de perspectiva
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Com vista a um ideal funcionamento do modelo no processo de animacao, as areas do
olho e da boca necessitam de ser construidas imitando a forma dos musculos da face humana.
Como George Bridgman refere no seu classico livro de desenho de anatomia, Bridgman’s
Complete Guide to Drawing From Life, “os olhos e a boca sdo envolvidos por musculos de
forma circular. Estes musculos funcionam primariamente para fechar o olho e a boca”

(Bridgman, 1952:114). Como tal, a organizacao da sua geometria devera ser em loops.

Seleccionamos o edge loop exterior e fazemos uma extrusdo. Utilizando as ferramentas
Move e Scale, alargamos e ajustamos o novo loop, como na Fig. 3.67. Repetimos este passo
mais duas vezes. Convém termos loops suficientes para que 0 modelo possa, mais tarde, criar

boas deformacdes, ao fazermos o olho fechar, pestanejar e agir de qualquer outra maneira.

Fig. 3.67 — Adicionando e ajustando novos loops

Seleccionamos agora as arestas indicadas na Fig. 3.68 e extrudimo-las.

Fig. 3.68 — Extrusdo de arestas

Fazemos o0 mesmo para as arestas indicadas na Fig. 3.69.

Fig. 3.69 e 3.70 — Extrusao de arestas
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Executamos agora uma extrusdo como apontado na Fig. 3.71 e fundimos os vértices de
modo a obtermos o resultado mostrado na Fig. 3.72. As éareas onde mais de quatro arestas se
cruzam quebram a fluidez da geometria. Esta que ocorre abaixo do olho ajudara a dar a

impressdo de 0sso malar quando suavizarmos o modelo.

Fig. 3.71 e 3.72 — Extrusdo da aresta e fusdo dos vértices, quebrando a fluidez da geometria

Detenhamo-nos um pouco para adicionar um edge loop e ajustar os vértices da geometria
gue temos até ao momento, que sdo ja suficientes para definir melhor as péalpebras e o
sobrolho. Esta é uma zona que necessita de uma boa quantidade de loops, para que a
animacdo das palpebras seja eficaz. Uma vez que “toda a estrutura que envolve o olho é
concebida para proteger esta vulneravel e expressiva particularidade do rosto” (Bridgman,
1952:120), e tendo nocao que as palpebras funcionam irreflectidamente, é natural que esta

seja uma das &reas do rosto onde ocorre mais animagao.

Fig. 3.73 — Ajuste da geometria

Seleccionamos agora as arestas indicadas na Fig. 3.74 e extrudimo-las duas vezes,

ajustando-as a cada extruséo.

Fig. 3.74 e 3.75 — Extrusdo de arestas
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Fazemos 0 mesmo para as arestas indicadas na Fig. 3.76, definindo a cana do nariz, tendo
em conta a sua anatomia; como Bridgman refere, “a medida que desce, [0 nariz] vai alargando
em largura e em volume, e na base é sustentado no meio e apoiado dos lados por cartilagens.

A parte de osso s vem até meio caminho” (Bridgman, 1952:125).

Fig. 3.76 e 3.77 — Extrusao de arestas Fig. 3.78 — Vista lateral

Convem irmos visualizando a nossa geometria suavizada, para podermos ter uma melhor
nocdo de como estd a ficar e que alteracdes devemos fazer. O processo mais simples é
seleccionar a geometria e premir a tecla 3, a qual activa 0 modo de visualizagdo em

Subdivis@es, que constitui um outro tipo de superficie existente no Maya além dos poligonos.

Fig. 3.79 — Modo de visualizagdo em Subdivisdes

N&o nos esquecamos de ir gravando o ficheiro. E aconselhavel, alias, ir gravando em
ficheiros diferentes, para o caso de algo correr mal ndo perdermos tudo o que fizemos.

Facamos uma extrusao das arestas indicadas na Fig. 3.80.

Fig. 3.80 e 3.81 — Extrusao de arestas
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Iremos agora modelar o resto do nariz. Nesse sentido, comegamos por seleccionar e
extrudir duas vezes as quatro arestas indicadas na Fig. 3.82, ajustando-as de forma a criar uma

primeira versao da base do nariz, como mostra a Fig. 3.83.

Fig. 3.82 e 3.83 — Extrusao de arestas, criando uma primeira versao da base do nariz

De seguida, precisaremos de utilizar a ferramenta Split Polygon, para criarmos a area
exterior das narinas. Antes de a seleccionar, sera necessario aceder a sua caixa de opcoes e
desactivar a propriedade Split only from edges. Isto permitira criar vértices, ndo s6 ao longo
de arestas, como também de faces. Deste modo, conseguiremos atribuir a esta zona do nariz
uma geometria mais orientada para a sua forma arredondada. Assim sendo, criemos as arestas

destacadas na Fig. 3.84. A seguir, criamos as da Fig. 3.85.

Fig. 3.84 e 3.85 — Adicdo de arestas com a utilizagdo da ferramenta Split Polygon

Com a mesma ferramenta, adicionamos as arestas que surgem a laranja na Fig. 3.86 e

eliminamos a que surge a vermelho. A seguir, criamos as indicadas na Fig. 3.87.

Fig. 3.86 e 3.87 — Adic&o e remogdo de arestas
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Ajustemos a posicao dos vértices & semelhanga da Fig. 3.88, formando a area exterior das
narinas e aperfeicoando a base do nariz. Apagamos as arestas seleccionadas, tendo o cuidado
de utilizar para esse efeito a ferramenta Delete Edge/Vertex, de modo a apagar também o0s

vertices. A seguir, adicionamos as arestas indicadas na Fig. 3.89.

Fig. 3.88 e 3.89 — Remogéo e adicdo das arestas indicadas

Agora com recurso a ferramenta Insert Edge Loop, adicionamos o edge loop indicado na
Fig. 3.90, ajustando os vértices uma vez mais. Podemos verificar novamente como esta a ficar
0 nosso modelo no modo de Subdivisdes. Desta vez, podemos experimentar duplicar a
geometria, de modo a obtermos a outra metade. Para tal, comegcamos por seleccionar a
geometria e movemos 0 seu ponto pivé para o centro do eixo X. Para o fazer, premimos a
tecla Insert, para entrar no modo de edi¢éo do ponto pivd e, enquanto premimos a tecla X para
activar o Snap to Grids, movemo-lo em X até ao centro do eixo. Voltamos a premir a tecla
Insert para sair do modo de edi¢cdo do ponto pive. Vamos agora a Edit > Duplicate Special
(caixa de opgdes), alterando a primeira caixa de valores de Scale para -1. Aplicamos as
alteracOes e obtemos, assim, a outra metade do rosto. Quando pretendemos combinar as duas
metades num sO objecto, seleccionamo-las e vamos a Mesh > Combine, ou usamos o atalho
existente na shelf. A seguir, seleccionamos os vértices situados no eixo ZY e unimo-los. Para
que a unido se dé apenas entre 0s vertices que se encontram exactamente N0 Mesmo espaco

fisico, acedemos & caixa de op¢des da ferramenta Merge e alteramos o Threshold para 0.001.

Fig. 3.90 — Adicéo do edge loop indicado Fig. 3.91 — Modo de visualizagdo em Subdivisdes Fig. 3.92 — Vista lateral
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Queremos agora criar a narina. Para o fazermos, comegamos por extrudir as faces
indicadas na Fig. 3.93. Escalamo-las para dentro, como na Fig. 3.94 e eliminamo-las. Depois,

fundimos os trés vertices indicados na Fig. 3.95 e eliminamos a aresta.

Fig. 3.95 — Fundir vértices e eliminar aresta

Eliminamos as arestas indicadas na Fig. 3.96, fundindo os vértices da Fig. 3.97.
Posteriormente, com a ferramenta Split Polygon, acrescentamos dois vértices como indicado

na Fig. 3.98, fundimo-los e ajustamos a geometria, obtendo o resultado mostrado na Fig. 3.99.

Fig. 3.98 e 3.99 — Acrescentar vértices, obtendo o resultado mostrado
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Eliminemos a aresta seleccionada na Fig. 3.100, fundindo os vértices indicados. De
seguida, adicionamos as arestas indicadas na Fig. 3.101, concedendo mais detalhe a narina.
Esta parte do rosto humano esta envolvida, ainda que subtilmente, em mdltiplas expressoes
faciais, pois “a porcdo cartilaginosa ¢é bastante movivel. As alas sdo elevadas no riso, dilatadas
na respiracdo profunda, contraidas no desagrado e alas e ponta do nariz sdo erguidas no
desprezo, enrugando a pele sobre o nariz” (Bridgman, 1952:127). Como tal, € importante que

a sua geometria seja orientada para uma boa deformacao.

Fig. 3.100 — Eliminar aresta e fundir vértices Fig. 3.101 — Adicionar arestas

Vamos agora dedicar-nos a expandir um pouco mais a geometria da cabeca; voltaremos a
narina posteriormente. Seleccionamos, entdo, as arestas indicadas na Fig. 3.102 e fazemos

uma extrusdo, ajustando a geometria como habitual.

Fig. 3.102 e 3.103 — Extrusdo das arestas indicadas

Extrudimos duas vezes as arestas indicadas na Fig. 3.104, ajustando-as como mostrado na

Fig. 3.105. Estamos a comegar a modelar o maxilar do nosso modelo.

Fig. 3.104 e 3.105 — Extrusdo das arestas indicadas

42



Modelagéo do Rosto Humano Realista

Extrudimos trés vezes a aresta indicada na Fig. 3.106, dando continuidade ao maxilar,

culminando no queixo, no centro do eixo X.

Fig. 3.106 e 3.107 — Extruséo da aresta indicada

Extrudimos também trés vezes a aresta indicada na Fig. 3.108, culminando igualmente no
centro do eixo X, comegando a formar o pescoco. A seguir, extrudimos quatro vezes as

arestas indicadas na Fig. 3.109, para formar a garganta.

Fig. 3.108 e 3.109 — Extrusdo das arestas indicadas

Agora extrudimos trés vezes as arestas indicadas na Fig. 3.110, fazendo coincidir cada
extrusdo com as arestas criadas anteriormente. De seguida, fundimos os Vértices

correspondentes, indicados na Fig. 3.111.

Fig. 3.110 e 3.111 — Extruséo das arestas seleccionadas, fundindo de seguida os vértices indicados Fig. 3.112— Vista lateral
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Alteremos um pouco a geometria da garganta, com as ferramentas Split Polygon e Delete
Edge/Vertex, para reduzir um pouco o detalhe, pois convém ter apenas a quantidade essencial.

Fig. 3.113 e 3.114 — Reduc&o da quantidade de geometria na garganta

Damos agora inicio & modelagdo dos l&bios. Na vista frontal, com a ferramenta Create
Polygon, definimos onze pontos, como mostra a Fig. 3.115. Extrudimos as arestas, ajustando
os Vvértices e eliminando a face interior e a do lado esquerdo. Alinhamos agora 0s vértices

mais a esquerda pelo centro do eixo com a ajuda do Snap to Grids, como mostra a Fig. 3.116.

Fig. 3.115 e 3.116 — Inicio da modelagéo dos labios, usando as ferramentas Create Polygon e Extrude

Puxamos este pedagco de geometria para o sitio correcto, em Z. Precisamos ainda de
juntar os dois pedagos de geometria hum so, através do comando Combine. Voltamos a
extrudir as arestas indicadas na Fig. 3.116, ajustando-as ligeiramente de acordo com os labios
das imagens de referéncia, como acontece na Fig. 3.117. A seguir, extrudimos as cinco arestas

de cima, unindo os seus vértices com a restante geometria conforme mostrado na Fig. 3.118.

Fig. 3.117 e 3.118 — Extrus&o das cinco arestas de cima, unindo-as a restante geometria
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Fazemos 0 mesmo para as arestas do labio inferior: seleccionamos as cinco arestas de
baixo e extrudimo-las, como mostra a Fig. 3.119, unindo entdo os seus vértices ao resto da

geometria, a semelhanca do que fizemos para a parte superior e tal como mostra a Fig. 3.120.

Fig. 3.119 e 3.120 - Extrusdo das cinco arestas de baixo, unindo-as a restante geometria

Adicionemos arestas como ocorre na Fig. 3.121, com a ferramenta Split Polygon.
Precisamos de adicionar mais arestas, conforme mostra a Fig. 3.122. Fundimos o0s veértices

indicados na Fig. 3.123, eliminando a aresta, para fazer a ligacdo que mostra a Fig. 3.124.

}, \l \ N\ t ,\‘\

Fig. 3.123 — Fundir os Vértices e eliminar a aresta Fig. 3.124 — Criacéo de nova ligacéo
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Adicionamos arestas como na Fig. 3.125, unindo os veértices indicados, dois a dois.
Eliminamos a aresta marcada a vermelho na Fig. 3.126, adicionando as restantes. Com a
ferramenta Split Polygon, criamos o vértice que quebra o triangulo junto ao nariz, como
mostra a Fig. 3.127, unindo-o ao vértice acima. A seguir, conforme mostrado na Fig. 3.128,
inserimos dois loops que permitirdo definir melhor os labios, e criamos as arestas abaixo, que
servirdo para fechar a abertura junto ao nariz. E importante saber que “a parte dos maxilares
em que os dentes se dispdem tem um formato cilindrico e controla a forma da boca. Se o
cilindro for achatado na frente, os labios serdo finos e a boca uma fenda. Quanto maior for a
curva deste cilindro, mais cheios e em forma de arco serdo a boca e os labios” (Bridgman,
1952:130). O actor Jason Statham, principal referéncia desta personagem, tem labios finos, o

que significara que a disposicdo dos seus dentes tera que seguir esta ldgica.

Fig. 3.127 — Criar vértice e uni-lo ao superior Fig. 3.128 — Adicionar edge loops e restantes arestas
Eliminamos a aresta a vermelho na Fig. 3.129, acrescentando as restantes. Apagamos 0

tridangulo indicado na Fig. 3.130 e tapamos a abertura com a ferramenta Append to Polygon.

Fig. 3.130 — Eliminar a face indicada, tapando a
restantes abertura com a ferramenta Append to Polygon
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Pode acontecer que seja impossivel eliminar alguma aresta, como a da Fig. 3.129. A
partida, isto deve-se ao facto de as faces que cridmos para a boca estarem ao contrario; as suas
normais (vectores perpendiculares as superficies) estdo voltadas para o interior da cabeca, ao
contrario das normais da restante geometria. Para resolver este problema, precisamos, antes de
mais, de saber quais séo, ao certo, as faces cujas normais estdo viradas para dentro. Para tal,
precisamos de tornar visiveis as normais, em Display > Polygons > Face Normals. A seguir,

precisamos de vira-las ao contrario. Assim, seleccionamo-las e vamos a Normals > Reverse.

Eliminamos a aresta marcada a vermelho na Fig. 3.131, adicionando as que se encontram
seleccionadas, unindo, por fim, os dois vértices indicados. Abaixo do nariz, inserimos as

arestas indicadas na Fig. 3.132 com a Insert Edge Loop, unindo os Vvértices.

Fig. 3.131 — Eliminar aresta a vermelho, criando as Fig. 3.132 — Adicionar arestas e unir vértices.
seleccionadas e unindo os vértices

Extrudimos quatro vezes as arestas apontadas na Fig. 3.133, definindo o topo do cranio.

A seguir, extrudimos a aresta seleccionada na Fig. 3.134, unindo os vértices indicados.

Fig. 3.134 — Extrudir a aresta trés vezes, unindo os vértices indicados
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Precisamos agora de preencher a abertura em que surgird a orelha. Conforme instruido
anteriormente, seleccionamos as arestas e, enquanto premimos a tecla Shift, clicamos com o
botdo direito do rato, esperando que surja 0 menu, de onde escolhemos a opcdo Fill Hole.

Seleccionamos esta nova face e fazemos-lhe uma extrusao, de acordo com a Fig. 3.135.

Podemos concluir ja o resto do crénio, através de extrusdes e unides de vértices como

temos feito até agora.

Fig. 3.135 — Extrusdo da face onde ira surgir a orelha Fig. 3.136 — Cranio concluido

Voltemos por breves momentos a narina, que ficou por completar. Seleccionamos as
arestas que contornam a abertura e fazemos algumas extrusées nariz acima, como mostra a
Fig. 3.137, apenas a distancia suficiente para que, posteriormente, o espectador nunca tenha a

oportunidade de vislumbrar o fundo da narina. Depois da Gltima extrusdo, tapamos a abertura.

Fig. 3.137 — Extrusdo da narina

As Fig. 3.138 e 3.139 mostram 0 nosso progresso até ao momento.

Fig. 3.138 — Vista frontal Fig. 3.139 — Vista lateral
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Vamos agora comecgar a modelar a orelha. Mudemos para a vista lateral, onde ela é mais
relevante. Comegamos com um novo cubo, que posicionamos como mostra a Fig. 3.140. A

seguir, extrudimos a face do topo conforme acontece na Fig. 3.141.

Fig. 3.140 e 3.141 — Inicio da modelag&o da orelha

Vamos precisar de unir os vértices indicados na Fig. 3.142, pelo que precisamos de
eliminar as respectivas faces, para que ndo fiquemos com faces desnecessarias. O mesmo se
aplica as faces de tras, seleccionadas na Fig. 3.143, que trataremos igualmente de eliminar.

Aproveitemos ainda para inserir o edge loop marcado a vermelho.

Fig. 3.142 — Eliminar a face e unir os vértices Fig. 3.143 — Eliminar faces de trés e inserir edge loop

Eliminamos a aresta indicada na Fig. 3.144, com a ferramenta Delete Edge/Vertex, e
utilizamos o Snap to Points (atalho: tecla V) para fazer coincidir os vértices da orelha
indicados com os respectivos da cabeca. Adicionemos as arestas seleccionadas na Fig. 3.145,

gue ddo a volta a orelha, com a ferramenta Split Polygon, unindo depois os vértices indicados.

Fig. 3.144 — Eliminar a aresta e alinhar vértices Fig. 3.145 — Adicionar arestas e unir vértices
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Adicionamos mais duas séries de arestas a volta da orelha, conforme mostrado na
Fig.3.146, puxando-as para dentro, dando forma a orelha. Com a ferramenta Split Polygon,

criamos a sequéncia de cinco arestas seleccionada na Fig. 3.147.

Criamos as ligagOes exibidas na Fig. 3.148, criando seguidamente a rede de arestas
mostrada na Fig. 3.149. A quantidade de geometria que iremos adicionar a orelha justifica-se
apenas pela complexidade da sua forma, ndo por motivos de animacao, visto que “a orelha, no
homem, perdeu praticamente todo o movimento. Os seus musculos, que em tempos
primitivos, sem davida, conseguiam mové-la para captar sons fracos, agora apenas formam

rugas que, embora variem largamente, t€ém certas formas definidas” (Bridgman, 1952:122).

Fig. 3.148 e 3.149 — Adicionar arestas

N&o nos esquecamos de ir vendo o modelo da orelha em Subdivisdes, para termos uma

melhor nogdo do resultado que estamos a obter e de que altera¢fes devem ainda ser feitas.

Fig. 3.150 — Vista frontal Fig. 3.151 — Vista lateral
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Ainda precisamos de adicionar mais detalhe, ndo s6 para definir melhor a orelha, como
também para resolver os tridngulos e n-gons que temos. Como tal, comegamos por adicionar

as arestas indicadas na Fig. 3.152 e 3.153.

Fig. 3.152 e 3.153 — Adicionar arestas

Extrudimos algumas vezes a face indicada na Fig. 3.154, de modo a formar a cavidade
que corresponde ao canal auditivo, até sensivelmente ao timpano, apenas para que,
posteriormente, o fundo nunca seja passivel de ser vislumbrado pelo espectador, a semelhanca

do que pretendemos para a narina.

Fig. 3.154 e 3.155 — Extrudir canal auditivo

O restante procedimento baseia-se somente em adicionar mais arestas e a puxar vértices
de modo a definir melhor a orelha, segundo os processos até aqui aplicados. No final,
eliminamos as faces da cabeca onde a orelha assenta, fazemos Combine da geometria da

orelha & da cabeca e unimos os vértices. As Fig. 3.156 e 3.157 mostram o resultado atingido.

Fig. 3.156 e 3.157 — Resultado final da orelha
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3.2.5.1 O Interior da Boca

Mesmo quando se trata de uma personagem que nao iré falar, se quisermos o minimo de
realismo presente, convém que o interior da sua boca tenha sido trabalhado, uma vez que pode
ser necessario que a personagem abra a boca ao esbocar uma expresséo facial, por exemplo.
Nesse sentido, seleccionamos as primeiras arestas que cridmos para os labios e extrudimos
diversas vezes para o interior da boca, reproduzindo-o a semelhanga do que acontece na

realidade e mostra a Fig. 3.158.

Fig. 3.158 — Corte longitudinal da boca

Agora precisamos de preencher o espago com dentes, gengiva e lingua.

Quatro formas diferentes serdo suficientes para fazer os dentes. Posteriormente,
modificamos-lhes um pouco a forma, para que um incisivo ndo seja exactamente igual a
outro. A semelhanca da cabeca, s6 precisamos de fazer metade da denticio. Podemos, no
entanto, utilizar o processo de box modeling, que neste caso demonstra ser mais directo e
eficaz, por se tratar de elementos que ndo contém aberturas na sua geometria. Assim, para
cada dente, criamos um cubo. As Fig. 3.159 a 3.166 mostram, através de vistas frontais e

laterais, um exemplo de como podem ser modeladas as quatro diferentes formas de dentes.

Fig. 3.159 e 3.160 — Vistas frontal e lateral do incisivo
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Fig. 3.161 e 3.162 — Vistas frontal e lateral do canino

Fig. 3.165 e 3.166 — Vistas frontal e lateral do molar

Precisamos agora de os dispor na ordem correcta, no interior da boca, tal como mostra a

Fig. 3.167, para que possamos modelar as gengivas, que se adaptardo a sua disposicao.

Fig. 3.167 — Disposi¢do dos dentes no interior da boca
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Para modelar a gengiva, podemos comecar igualmente com um cubo, ao qual vamos
adicionando edge loops, extrudindo faces e ajustando os vértices, de acordo com a disposicao
e forma dos dentes, como mostram as Fig. 3.168 e 3.169. Devemos certificar-nos de que a

base dos dentes fica no interior da gengiva, fazendo com que esta os cubra parcialmente.

Fig. 3.168 e 3.169 — Vistas frontal e lateral do molar

Para a lingua, basta modelar um cubo até obter uma forma simples, como a exibida nas
Fig. 3.170 e 3.171.

Fig. 3.170 — Vista de topo da lingua Fig. 3.171 — Vista frontal da lingua

Fig. 3.172 — Vista lateral da lingua
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O resultado final deve assemelhar-se ao mostrado nas Fig. 3.173 e 3.174, depois de

duplicarmos para o lado esquerdo.

Fig. 3.173 e 3.174 — Vistas frontal e lateral do interior da boca

A partir daqui, podemos, entdo, fazer algumas alteracbes nos dentes, de forma a néo

serem exactamente idénticos e simétricos. Concluimos, assim, o interior da boca.

3.2.5.200lho

Podemos pensar que o olho pode simplesmente ser representado por uma esfera. Uma vez
mais, se estamos a procura de realismo, ndo é essa a solucdo adequada. O olho ndo é
perfeitamente esférico, visto que a cornea forma uma espécie de clpula, como podemos
verificar no diagrama da Fig. 3.175, além de que a iris se encontra um pouco atras, sendo

visivel através da transparéncia da cérnea.

ORA SERRATA M. RECTO SUPERIOR
CORPO CILIAR /J/
/ ESCLEROTICA

CONJUNTIVA
LIMBO
CANAL DE SCHLEMM

CORNEA

CRISTALINO

CAMARA ANTERIOR ﬁ

(HUMOR AQUOSO)

NERVO OPTICO

iRIS "~ ARTERIAE VEIA
CENTRAIS DA RETINA

CAMARA POSTERIOR i
DISCO OPTICO

HUMOR VITREO 1 M. RECTO INFERIOR

Fig. 3.175 — Diagrama do olho

ZONULA

N&o se trata simplesmente de uma questdo de perfeccionismo. D& certamente bastante
mais trabalho e leva mais tempo do que utilizar uma simples esfera, mas se um olho for
modelado respeitando a sua versdo real, os resultados em termos de realismo serdo bastante
melhores, compensando cada minuto despendido.
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Escusado sera dizer que, tal como tudo o que cridmos até aqui, existem Varios processos
de modelacdo de um olho realista. O que aqui é apresentado trata-se de uma adaptacdo de

alguns processos analisados, de forma a poder criar o modelo estritamente em poligonos.

Comecamos, entdo, inevitavelmente, por criar uma esfera. Na Channel Box, em INPUTS,
alteramos o seu valor de Subdivisions Axis para 16 e o de Subdivisions Height para 12.
Rodamo-la 90° em X. A seguir, inserimos um edge loop como indicado na Fig. 3.177. Esta
delimitara o didmetro maximo da cornea. Para inserir um edge loop exactamente no meio de
duas arestas, vamos a caixa de opcOes da ferramenta Insert Edge Loop, activamos a opg¢éo
Multiple edge loops e, em Number of edge loops, alteramos o valor para 1. Depois, clicamos,

como habitual, na aresta onde pretendemos adicionar o loop.

Fig. 3.176 — Esfera ap6s rotagdo de 90° em X Fig. 3.177 — Inserir edge loop indicado

Olhando para a Fig. 3.178, tendo em conta que o edge loop marcado a vermelho se trata
do que acabamos de criar, inseriremos mais trés; podemos inserir ja um deles, um pouco
abaixo do primeiro. Se agora tentarmos adicionar, pelo mesmo processo, 0s outros dois, que
se deverdo situar entre o veértice do topo da esfera e o edge loop que o antecede, constatamos
que ndo é possivel. Para contornar este obstaculo, utilizaremos a ferramenta Cut Faces, mas
antes de a seleccionarmos, acedamos a sua caixa de opgdes. Precisamos de alterar a Cut
direction para XY Plane. Verificamos que surgem, no viewport, um manipulador e um plano
de corte. Arrastamo-lo em Z até a projecgdo do corte estar no local onde devera estar o loop

mais proximo do vértice do topo. Podemos inserir o ultimo com a ferramenta que preferirmos.

Fig. 3.178 — Adicionar os trés edge loops seleccionados
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Eliminamos as arestas da extremidade indicadas na Fig. 3.179, suprimindo os tridngulos.
Repetimos este passo no outro lado da esfera. Depois, seleccionamos os vértices indicados na

Fig. 3.180 e puxamo-los um pouco a frente, formando a clpula que representa a cérnea.

Fig. 3.179 — Eliminar as arestas indicadas Fig. 3.180 — Puxar os vértices seleccionados

Se visualizarmos a geometria em Subdivisdes, apercebemo-nos de que se forma um pico
no centro da cornea. Seleccionamos 0s vértices em questdo e puxamo-los um pouco atras,

suavizando a curvatura.
O globo ocular e a cornea estao concluidos. Passemos a iris.

Vamos a Create > Polygon Primitives > Torus. Na Channel Box, em INPUTS, alteramos
o valor de Subdivisions Axis para 16 e o de Subdivisions Height para 10. Rodamos o objecto
90° em X e escalamo-lo de forma a encaixar no globo ocular como mostra a Fig. 3.181. A

seguir, achatamo-lo como acontece na Fig. 3.182.

Fig. 3.181 — Disposi¢éo do torus Fig. 3.182 — Achatar o objecto

Precisamos agora de modelar a iris de forma a torna-la mais similar a de um humano.
Enquanto a de determinados animais tem uma forma céncava, a iris do ser humano tem uma
forma convexa, como se verifica no diagrama da Fig. 3.175. Assim, comecamos por
seleccionar os edge loops indicados na Fig. 3.183 (os do outro lado também) e puxamo-los

um pouco a frente, como acontece na Fig. 3.184.
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Fig. 3.183 e 3.184— Puxar sensivelmente os edge loops, tornando a iris convexa

Seleccionamos, a seguir, os dois edge loops indicados na Fig.3.185 e empurramo-los para
tras, acentuando a convexidade da iris.

¥\ ~J
i \ / 2

Fig. 3.185 e 3.186 — Acentuar a convexidade da iris, empurrando os edge loops indicados

Por ultimo, seleccionamos o edge loop indicado na Fig. 3.187 e alargamo-lo, como

acontece na Fig. 3.188.

Fig. 3.187 e 3.188 — Seleccionar o edge loop e alarga-lo

A iris estd, assim, concluida. No entanto, iremos ainda criar um objecto que colocaremos
atras da iris, para impedir que qualquer luz que ilumine a nossa personagem cause brilhos no
interior do olho. Criamos, portanto, uma esfera, a qual alteramos o seu valor de Subdivisions
Axis e Subdivisions Height para 8, rodamo-la 90° em X, achatamo-la um pouco e eliminamos

as faces indicadas na Fig. 3.189, obtendo uma cupula.
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Na fase de texturizagdo, esta cUpula tera que levar um material negro, que ndo cause

reflexos nem brilhos.

Fig. 3.189 — Eliminar faces Fig. 3.190 — A iris e a ctpula negra, na vista lateral
O globo ocular tera também que ser tido em atencdo nessa fase, dado que precisara de
levar um mapa de transparéncia, que torne transparente apenas a area da cornea transparente.

Agora, seleccionamos o0s trés objectos e agrupamo-los (Edit > Group [atalho: Ctrl + g]),

para que, guando rodarmos o globo ocular, a pupila e a cipula negra Ihe sigam o exemplo.

A Fig. 3.191 mostra o resultado obtido neste processo de modelagéo do olho.

Fig. 3.191 — Resultado final da modelagéo do olho

Duplicamos o grupo que o contém, de forma a obtermos o segundo olho, e colocamo-lo
na abertura do rosto devida, escalando-o até atingir as dimensdes adequadas. Fechamos agora

a abertura, criando a Orbita.
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Para finalizar, modelamos a plica semilunaris da conjuntiva, a prega de tecido organico
situada no canto interior do olho. Criamos um cubo e, através da inser¢do de edge loops e
ajuste dos vertices, atribuimos-lhe a forma, preocupando-nos somente com a sua parte visivel,

e encaixando-a na restante geometria, a semelhanca do que acontece na Fig. 3.192.

Fig. 3.192 — Plica semilunaris da conjuntiva

As Fig. 3.193 e 3.194 mostram o resultado final da modelacdo no Maya. O modelo ira
agora seguir para o software ZBrush, onde elevaremos o seu nivel de realismo através de uma

modelacdo mais organica, da quebra da simetria e da atribuicdo de rugas.

Fig. 3.193 — Resultado final — vista frontal

Fig. 3.194 — Resultado final — vista lateral
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3.2.6 Apresentagdo do Software ZBrush

ZBrush' é um programa de escultura e pintura digital, desenvolvido pela Pixologic, que
revolucionou a industria do 3D com 0s seus poderosos recursos e intuitivos métodos de
trabalho. O programa oferece as ferramentas mais avancadas do mundo aos artistas digitais de

hoje, permitindo o esboco rapido em 2D e 3D e posteriormente levar a ideia até a conclus&o.

E possivel criar renderizag@es realistas directamente no ZBrush, com iluminacio e efeitos
atmosféricos. Com as varias opc¢des de exportacao, facilmente se pode preparar o modelo para

impressdo tridimensional ou para uso em qualquer outra aplicacdo digital.

Gracas ao poderoso processamento do programa, é possivel esculpir e pintar com milhdes
de poligonos sem ter que haver a preocupacdo em comprar placas graficas dispendiosas. Por
esta razdo, o ZBrush é utilizado por toda a gente, desde entusiastas da arte aos grandes

estidios de cinema e videojogos.

Fig. 3.195 — Personagem do filme Pirates of the Fig. 3.196 — Modelo criado com recurso ao  Fig. 3.197 — Busto criado durante o periodo
Caribbean: Dead Man's Chest (Gore Verbinski, software, para um concurso online de testes do ZBrush 4
2006), modelada em ZBrush

Fig. 3.198 — Modelo de Avatar (James Cameron, 2009) concebido no ZBrush

! Informacdo retirada do blog do programa: http://www.pixologic.com/zbrush/features/01_Ul/

61


http://www.imdb.com/title/tt0383574/
http://www.imdb.com/title/tt0383574/
http://www.google.pt/url?url=http://www.imdb.com/name/nm0893659/&rct=j&sa=X&ei=9a5ITcXbK4K6hAeBkO3XBA&ved=0CCsQggkoADAA&q=pirates+caribean+dead+man+chest&usg=AFQjCNFliPCS7yzqTATb2zpdJFdrilouzA

Modelagéo do Rosto Humano Realista

A Pixologic conheceu recentemente novos avangos, com o langamento do ZBrush 4.
Atraveés da introducdo de ferramentas completamente novas e da expansao das utilidades do

ZBrush, a nova versao estabelece um novo standard em softwares de arte digital.

3.2.7 A fungéo GoZ

Uma das fungdes nucleares do ZBrush sempre foi a de fornecer aos artistas a capacidade
de criar num ambiente que permite completa liberdade de expressdo. Esta falta de barreiras

técnicas faz o trabalho no ZBrush assemelhar-se a escultura ou pintura do mundo real.

Com a funcdo GoZ, deixa de haver necessidade de investir tempo na configuracdo de
redes para 0os mapas de texturas. Com um Unico clique, o GoZ transfere 0 modelo para outra
aplicacdo compativel a escolha, configurando instantaneamente todas as redes apropriadas.
Ao enviar o modelo de novo para o ZBrush, o GoZ ira automaticamente remapear os detalhes
de alta resolucdo existentes no modelo, ainda que a sua topologia tenha sido significantemente
alterada na outra aplicacdo, deixando-o imediatamente preparado para detalhes adicionais.
Isto permite que o utilizador se concentre mais na sua arte do que nos processos de

exportacao/importacao.

3.2.8 Introducéo as Principais Ferramentas de Modelacéao

Comecemos por observar o interface do programa. No topo do ecra, situa-se um menu,

onde constam naturalmente todo o tipo de opcGes existentes no programa.

> ZBrush 4[ZWBM-BMCU-ADEJ-FYXO0] ZBrush Documen

Fig. 3.199 — O menu de topo

A direita, encontra-se o submenu Tool (nome que o ZBrush da aos
modelos 3D; cada Tool pode ser constituida por varias partes, chamadas
SubTools), onde se situam as opcdes directamente relacionadas com o
modelo. Aproveitemos para fazer o carregamento de uma Tool do ZBrush,

clicando em Load Tool e abrindo a DemoHead — constatamos que, assim

que o fazemos, surge uma lista de nomes no submenu Tool; clicar sobre

Fig. 3.200 — O submenu
Tool, a direita

qualquer um dos nomes faz abrir um novo separador, exibindo opc¢des a
ele referentes — e, de seguida, clicamos e arrastamos no viewport, fazendo
surgir, no tamanho que quisermos, 0 modelo de uma cabega de
demonstracéo.
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Antes de procedermos, reparemos que, logo abaixo do menu de topo, o botdo Draw esta
activado. Para possibilitar alteracbes na cabega, activamos 0 modo Edit, imediatamente a

esquerda, ou premindo a tecla T. Uma serie de op¢des torna-se disponivel.

No ZBrush, as ferramentas de modelacdo dao pelo nome de brushes (pincéis). Podemos
encontrar a palete de brushes a esquerda, no interface. Por pré-definicdo, a brush activada € a
chamada Standard, utilizada para adicionar relevo (Zadd) ou subtrair matéria (Zsub) a
geometria; enquanto seleccionada, se premirmos e arrastarmos o rato sobre a cabeca,
estaremos a adicionar relevo, dado que a opcdo Zadd esta activada, no topo. Se activarmos
Zsub — logicamente, a op¢do Zadd é desactivada — e clicarmos e arrastarmos sobre a cabeca,
causamos 0 oposto, ou seja, retiramos-lhe geometria. Opcionalmente, com qualquer um dos
modos activado, se pressionarmos a tecla Alt enquanto editamos, 0 modo oposto serad

activado. Isto aplica-se a qualquer brush que esteja activada.
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Fig. 3.201 — A palete de brushes
Se a brush estiver grande demais ou a intensidade demasiado alta, ajustamos a Z Intensity

e 0 Draw Size respectivamente; quanto mais baixo o valor, mais pequeno o efeito. Podemos,
ainda, alterar estes valores através de um pequeno menu gue surge quando premimos a barra

de Espaco do teclado.

Fig. 3.202 — As opgdes Zadd e Zsub, Z Intensity e Draw Size no interface

No processo de escultura, as brushes mais vulgarmente utilizadas, além da Standard, séo
a Inflate, Smooth e Move; a Inflate é a melhor opcdo para expandir pequenas secgdes; a
Smooth, como 0 nome sugere, permite suavizar a geometria, atenuando saliéncias ou sulcos; a

Move é Optima para deslocar ou retocar areas do modelo.

Temos outro modo de aplicar detalne no modelo; abaixo da palete de brushes,
escolhemos um tipo de Stroke e a seguir, abaixo, seleccionamos um Alpha. Seguidamente,
fazemos a edicdo no modelo. Esta pode ser uma forma eficaz de adicionar o detalhe que

precisarmos, até porque é possivel criar um alpha personalizado, com recurso ao Photoshop.
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A semelhanca de outros programas de arte digital, como o préprio Photoshop, o ZBrush
possui um modo de edigcdo por layers (camadas). Isto permite que adicionemos detalhe que
pode ser tornado visivel ou invisivel a qualquer altura. Deste modo, podemos fazer alteragdes
no modelo sem comprometer a sua forma original. Podemos, inclusivamente, criar layers
adicionais, criando o detalhe que desejarmos na layer que pretendermos, 0 que permite
combinar os detalhes de cada uma delas. Para criarmos uma, abrimos o separador Layers e

clicamos no botao New.

Para activarmos o modo de edi¢do em simetria, vamos a Transform do menu de topo e
clicamos em Activate Symmetry. Quando estivermos a editar a nossa cabeca, temos que nos
certificar de que o X esta activado, dado que é esse 0 eixo que a divide em duas metades

simétricas. Podemos activar ou desactivar o modo de edi¢do em simetria premindo a tecla X.

Uma das principais razdes por que usaremos 0 ZBrush na criacdo de uma cabeca realista
é pela sua possibilidade de trabalhar com milhGes de poligonos. Atentando, por exemplo, na
cabeca que temos diante de nos, podemos aperceber-nos de que é constituida por milhares de
pequenas faces. No entanto, se subdividirmos a sua geometria umas quantas vezes e
experimentarmos edita-la, verificaremos que se torna bastante mais facil adicionar o detalhe
mais infimo que pretendermos. Para subdividir a geometria, vamos ao separador Geometry do

submenu Tool e clicamos em Divide.

3.2.9 Elevando o Nivel de Realismo do Rosto Humano

Antes de um modelo ser enviado para o ZBrush, os UVs (coordenadas bidimensionais
que comunicam a todas as aplicagdes 3D como aplicar a textura num modelo) devem ser
arranjadas. O ZBrush possui um aplicativo gratuito, o0 UV Master, que cria automaticamente
os UVs de uma forma bastante eficiente. Claro que podemos sempre recorrer a0 processo

manual no Maya, dependendo da nossa preferéncia.

Precisamos, tambeém, de instalar o aplicativo GoZ no Maya. Para o fazer, abrimos o
ZBrush 4 e acedemos a Preferences > GoZ, do menu de topo, actualizando o caminho para a

nossa versao do Maya.
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Abrindo agora o Maya, verifica-se que uma nova shelf, “GoZBrush”, foi criada, contendo
0 bot&o que precisaremos de premir sempre que quisermos enviar 0 nosso modelo do Maya
para o ZBrush. Por seu lado, o ZBrush tem também uma sec¢do dedicada ao GoZ no submenu

Tool, com algumas opcoes:

- GoZ: envia a SubTool seleccionada para a outra aplicag&o.

All Visible R

- All: Envia todas as SubTools da Tool seleccionada para a outra

aplicacdo, estejam ou nao visiveis.

- Visible: Envia apenas as SubTools visiveis da Tool seleccionada

para a outra aplicacao.

- R (Reset): Desactiva a ligagdo com a outra aplicagdo. Da vez ™9 3203~ Comandosdo Goz no

seguinte que um dos outros comandos for accionado, uma caixa

de dialogo pedira para escolher uma nova aplicacao.

Antes de enviarmos o0 nosso modelo para o ZBrush, precisamos de ter a certeza de que a
geometria ndo tem qualquer tipo de problema, como n-gons, “faces-lamina” (faces com
menos de trés lados) ou faces sobrepostas. Se porventura enviarmos 0 modelo com problemas
destes para o ZBrush sem nos apercebermos atempadamente, posteriormente verificaremos
graves problemas na geometria, que nos fardo deitar fora e repetir incontiveis horas de
trabalho. A fig. 3.204 mostra um problema ocorrido devido a existéncia de faces sobrepostas.

-_—>r

Fig. 3.204 — Problema resultante de faces sobrepostas

Para nos certificarmos, entdo, de que a geometria esta livre de problemas, vamos a Mesh
> Cleanup. Uma caixa de opg¢des abre-se. Podemos escolher o tipo de problemas que
queremos que 0 Maya procure e 0 que queremos que ele faga: identificar as areas em questéo,
para que possamos resolvé-las nds, ou apaga-las automaticamente. Quando nos tivermos
certificado de que ndo h& qualquer problema, seleccionamos a cabega, clicamos no botdo GoZ
e, ndo tarda, temos o nosso modelo a postos no ZBrush. Desenhamo-la no viewport e
clicamos em Edit.
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Antes de lhe subdividirmos a geometria, convém ter em mente que ha casos em que é
conveniente armazenar um Morph Target, ou seja, guardar a actual geometria do nosso
modelo. Esta € uma das opg¢des do submenu Tool. Clicamos, entdo, em Morph Target,
fazendo o separador expandir-se. Premimos o Unico botdo disponivel de momento, StoreMT.
Assim que o fazemos, outras opg¢des tornam-se disponiveis. Se agora subdividirmos algumas
vezes 0 nosso modelo, em Geometry > Divide, e voltarmos ao nivel inicial, verificamos que a
sua forma ja ndo é bem a mesma. Isto acontece porque, ao executar as subdivisfes, 0 ZBrush
suaviza as formas, tornando o modelo mais compacto. Se formos novamente a Morph Target
e premirmos, desta vez, o botdo Switch, a nossa forma inicial regressa. Se movermos o slide
das subdivisdes para a maxima divisdo que criamos, as suas formas deverdo ser mais

aproximadas ao que esperavamos.

Lembremo-nos de ligar a simetria em X para que, pelo menos para ja, todas as alteracbes

que fizermos numa metade do rosto sejam aplicadas também no outro.

A partir daqui, ndo ha uma forma estrita de proceder. Podemos comecar com a brush
Move, puxando e recolocando alguns aspectos do modelo, como o nariz, os labios, as macas
do rosto, o sobrolho, as orelhas e a macé-de-ado. E aconselhavel utilizar, por exemplo, livros
de anatomia como referéncia, para que possamos criar uma representacdo tridimensional
realista, com 0 maximo de rigor possivel. Para a concepcdo deste modelo, por exemplo, foram
tomadas como referéncia fotografias do actor Jason Statham, em que a personagem foi
inspirada, assim como imagens, fotografias e informacdo de livros como Anatomy For The

Artist, de Sarah Simblet, ou Atlas of Human Anatomy for the Artist, de Stephen Rogers Peck.

Fig. 3.205 — Vistas de frente e de lado do modelo depois de uma passagem com a brush Move

Utilizando as brushes Standard e Smooth, podemos acrescentar “barro digital” onde
precisarmos de dar ou retirar volume, como por exemplo nas palpebras. Com a mesma

finalidade, podemos utilizar a Inflate nas cartilagens da orelha, se 0s quisermos engrossar.
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Quando a forma da cabeca em geral estiver do nosso agrado, desactivamos a simetria,
para comegarmos a acrescentar os detalhes que irdo diferenciar uma metade do rosto da outra.
Novamente com a brush Move, alteramos, por exemplo, a forma de uma das orelhas,
entortamos o nariz levemente para um dos lados, fazemos descair um dos lados dos labios,
fechamos um pouco mais um dos olhos, etc. Posteriormente, alternando entre o Zadd e o
Zsub, utilizamos a brush Standard, criando as rugas de expressao nos cantos dos olhos, na
testa, abaixo das palpebras. Se estivermos a contar fazer planos aproximados da nossa

personagem, vale a pena criar um mapa alpha no Photoshop, para criarmos os poros da pele.

Fig. 3.206 — Vista frontal do modelo apds tratamento de assimetria e criagdo de rugas

O processo de edicdo do nosso modelo no ZBrush fica assim concluido. Agora
precisamos de converter todas as alteracfes que fizemos em informacdo que o Maya seja

capaz de interpretar.

3.2.10 Displacement Map/ Normal Map

A informacéo de alta resolucéo que adiciond&mos ao nosso modelo no ZBrush tem que ser
lida pelo Maya através de mapas, dado que lhe & impossivel processar os milhdes de
poligonos que trabalhdmos no ZBrush. Estes mapas sdo imagens que contém a informacéo de
todos os detalhes que criamos no ZBrush; quando aplicadas ao modelo de baixa resolucéo,

alterardo a sua aparéncia, fazendo-o parecer de alta resolugéo.
67



Modelagéo do Rosto Humano Realista

O Displacement Map aplica a deformacéo que foi criada no modelo de alta resolucao ao
modelo de baixa resolucdo, baseado num ficheiro de imagem. Este tipo de mapa é o que a

maioria das companhias de cinema utiliza para adicionar detalhe aos seus personagens.

O Normal Map apreende a informacédo das normais dos poligonos de um modelo de alta
resolucédo e aplica-os ao de baixa resolucdo, fazendo com que este pareca ter muito mais
detalhe do que na verdade tem. Quando aplicado a um modelo num videojogo, consegue-se a
impressdo de se tratar de uma personagem muito detalhada, beneficiando de, na verdade, se
tratar um modelo com baixa contagem de poligonos, essencial para que o0 jogo se desenrole

fluidamente, sem arrastos.

Para criarmos o primeiro mapa, precisamos de baixar a resolucdo do modelo para a
primeira subdivisdo. A seguir, vamos ao separador Displacement Map do submenu Tool e
clicamos em Create DispMap. De forma a criarmos o segundo mapa, procedemos
praticamente da mesma maneira: com o modelo na primeira subdivisdo, acedemos as op¢des
do separador Normal Map e clicamos em Create NormalMap. Clicamos, entéo, no botdo GoZ,

e 0 modelo no Maya ¢é actualizado, com ambos os mapas aplicados.

A fig. 3.207 mostra uma renderizacdo do modelo no Maya.

Fig. 3.207 — Renderizagao frontal do modelo no Maya, com os mapas Displacement e Normal aplicados
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3.3 Concluséo de Capitulo

O CGI esta cada vez mais presente no nosso quotidiano, ndo se limitando somente ao
cinema, mas alastrando-se também a televisdo, a publicidade e inclusivamente a éareas
externas as indudstrias do entretenimento, como a arquitectura e a medicina. A constante
evolucdo da industria dos efeitos visuais tem desbloqueado progressivamente inimeras
possibilidades, inclusivamente a de conceber multiddes de gente criada por computador ou

duplos virtuais dos actores.

O guido completo para a modelacdo de uma cabeca humana realista para animacéo é um
passo na direccdo da mestria do procedimento, ndo s6 para o autor, que fortaleceu os
conhecimentos que j& possuia, como também para o leitor que pretende iniciar-se na
instrucdo. A distingdo entre um bom e um mau modelo depende de uma diversidade de
factores; os conhecimentos anatdmicos constituem uma parte fundamental para o rigor e
credibilidade do modelo. Ao mesmo tempo, uma boa ambientagdo ao software e suas
ferramentas de modelacédo elevam a destreza e celeridade no processo criativo. A alianca entre
0s conhecimentos técnicos e as nogOes teoricas é também imprescindivel para um bom
modelo; o facto de se organizar a geometria do modelo de acordo com a disposicdo dos

musculos da cara possibilita uma grande fluidez no posterior processo de animacéao.

A utilizagdo do software ZBrush revela-se uma valiosa fase do processo de modelacgéo,
ao permitir modificar o modelo de um modo bastante intuitivo e incutir pormenores que
ajudam a dar-lhe o aspecto realista e organico de um rosto humano que, s6 com recurso ao

software Maya, ndo seria tdo facilmente alcangavel.
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4 Desenvolvimento do Projecto Final

The Night Shift € um projecto individual que reline conhecimentos técnicos e artisticos
adquiridos, ndo s6 ao longo do curso de mestrado, como também da licenciatura de quatro

anos em Artes Digitais e Multimédia que o precedeu.

Este capitulo fara uma apresentacdo das diferentes fases da producdo do Projecto Final,

desde a concepcao do argumento até a pos-producéao.

4.1 Pré-Producéo

A fase inicial de um projecto é de uma importancia imensuravel, na medida em que se
estabelecem todos os alicerces que irdo sustentar a sua producédo; € nesta altura que se define,
entre outros elementos, a historia, 0s personagens, o tipo de enquadramento da camara e a

duracdo dos planos.

4.1.1 Argumento - A Evolucédo da Narrativa

A primeira versao do argumento iniciava a narrativa ja a meio de uma perseguicao entre
dois personagens idénticos, num hospital abandonado, envolvendo trocas de tiros e sem
qualquer didlogo. Nessa altura, ndo estava definido se os personagens seriam irmdos gémeos,
ou se um deles seria um robd, um clone ou um outro tipo de ser vivo, capaz de assumir
qualquer forma fisica. Contudo, em conversa com o0s professores Ricardo Megre e Pedro
Serrazina, ficou estabelecido que a narrativa precisava de responder a um minimo de
questdes, como 0 porqué da perseguicdo, ou a razdo de 0s personagens se encontrarem
naquele local, por forma a cativar a atencdo e o proprio interesse do espectador na historia.
Assim, o argumento foi sendo alterado ao longo de algumas semanas, até alcancar a estrutura
com que eventualmente ficou consolidado; foi criada uma terceira personagem que nunca €
vista, apenas ouvida através do walkie-talkie, e um didlogo, que foi igualmente sofrendo
alteracfes. A insercdo destes dois novos elementos na historia vieram ajudar, ndo so a
explicar ao espectador a razdo da presenca dos personagens naguele local, como também a

aumentar o nivel de tensdo, atraves de falhas na comunicacdo por meio do dispositivo movel.
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4.1.2 Storyboard e Animatic

Devido ao atraso de um més com que o projecto foi iniciado, esta fase da pré-producéo
assumiu um aspecto pouco artistico, mas ainda assim bastante técnico, na medida em que 0s
desenhos utilizados para a criacdo do storyboard’ e animatic? foram pouco trabalhados, mas
providos de animagdo e iluminagdo num cenario tridimensional, criado no software After
Effects, da Adobe. Assim, apesar de os desenhos ndo representarem fielmente aquilo que
estava planeado para o produto final, ajudaram bastante a formar uma ideia dos volumes, do
espaco que 0S personagens e outros elementos ocupariam no plano, do tipo de
enquadramentos e movimentos de camara que seriam feitos, das deslocacGes que os
personagens fariam no espaco, da intensidade e tonalidade de iluminacdo que preencheria o

cenario.

Para a parte sonora do animatic, foram utilizados sons provisorios, retirados de bancos de

sons da internet, e foi gravada a voz do autor para uma primeira versao do dialogo.
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Fig. 4.1 — Frames do animatic

! Storyboarding é um processo desenvolvido na Walt Disney Studio no inicio dos anos 30 que consiste na organizacdo de uma sequéncia de
ilustracOes cujo objectivo é o de permitir a pré-visualizagdo de qualquer tipo de filme.

Animatic € uma técnica que se segue a de storyboarding, geralmente utilizando as ilustracdes do mesmo, e visa dar uma ideia melhor,
através de movimento e timing, do aspecto final do filme.
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4.1.3 Imagens de Referéncia do Personagem

Antes de se ter tomado o0 actor Jason Statham como referéncia para os personagens,
houve uma pré-seleccdo, da qual constavam alguns outros actores, como Josh Holloway e
Mark Vanderloo. A utilizacdo de um actor como referéncia foi considerada uma vantagem,
uma vez que pouparia tempo que iria ser gasto a criar um rosto de raiz. Tendo em conta o
atraso com que o projecto ja havia iniciado, essa foi uma decisdo bastante importante. Foram,
portanto, feitos alguns retratos, em diferentes expressdes faciais, analisando-se as

potencialidades de cada actor. Statham foi, entdo, o eleito.

Foram, assim, criadas duas imagens mais rigorosas, para servirem de referéncia, uma de

frente e outra de perfil, para servirem de referéncia no software Maya.

As imagens de referéncia do corpo do personagem foram concebidas a parte das imagens

de referéncia da cabeca e rosto, com base no tipo de corpo atlético/musculado.

Fig. 4.2 — Alguns retratos de actores

Fig. 4.3 — Imagens de referéncia do actor eleito, Jason Statham Fig. 4.4 — Imagens de referéncia do corpo
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4.1.4 Mockup do Cenério

Dado o atraso de um més com que o projecto foi iniciado, todas as fases tiveram que ser
logicamente encurtadas. Uma vez que se ia tornando essencial que outras fases fossem sendo
adiantadas, a fase de criagdo do mockup do cenario teve inicio ja fora da etapa de pré-
producdo, posteriormente as fases de modelacéo e texturizacdo dos personagens. Ainda que
tenha tido que ser um pouco apressada, constituiu uma fase bastante importante no processo
de pré-producdo. A criacdo do mockup do cenério, ou seja, dos seus elementos basicos, como
paredes, portas e outros objectos, nas dimensdes aproximadas ao que viriam a ser no seu
aspecto final, mas sem pormenorizacéo, foi essencial para que se pudesse proceder a fase de
animacao, permitindo assim ter nocgéo, por exemplo, dos locais correctos onde 0s personagens

iniciariam ou terminariam a sua marcha.

Fig. 4.5 — Mockup do cenério - corredor, laboratério e lavabos. Esta primeira versdo do cenario permitiu criar uma
ideia aproximada dos volumes que o ocupariam, tendo sido Util para que a fase de animacéo pudesse tomar lugar
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4.2 Produgéo

A fase de Producéo é, sem divida, a mais longa e mais trabalhosa, mas também é aquela
que, logicamente, mais satisfacdo traz a alguém que ambiciona uma carreira na area da
criagdo tridimensional. Envolve a modelacdo de cenarios, personagens e aderecos, a

respectiva texturizacao, o rigging, a animagcéo, a iluminacéo e a renderizagéo.

4.2.1 Modelacao dos Cenarios

O argumento de The Night Shift envolve trés cenarios distintos, ainda que todos eles
facam parte do mesmo edificio, pelo que esta etapa requereu imenso tempo para que
pudessem ser produzidos todos os elementos constituintes dos diferentes espagos. Assim,
partindo-se do mockup previamente criado, os cenarios comecaram a ser desenvolvidos,
utilizando também como apoio a vasta pesquisa efectuada de videos, imagens e fotografias
representativas de hospitais abandonados, laboratérios futuristas e lavabos danificados. Ainda
que tenham sido muitas as influéncias para os cenarios e respectivas ambiéncias, as
referéncias dominantes foram os videojogos Silent Hill (Konami) para o espaco do corredor
do hospital, os filmes Tron: Legacy (Joseph Kosinski, 2010) e Resident Evil: Afterlife (2010),
de Paul W. S. Anderson para o laboratério e o videojogo Splinter Cell: Conviction (Ubisoft,
2010) para os lavabos. Todos os modelos do Projecto Final foram criados em poligonos,
devido a familiaridade com a sua utilizacdo. Todos 0s elementos constituintes do cenario

foram concebidos somente com o software Maya.

Fig. 4.6 — Referéncias dominantes para os cendrios e respectivas ambiéncias
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4.2.1.1 Corredor

O espago do corredor do hospital abrangeu também os quartos; foi criado 0 modelo de
uma cama e de um poste de administracdo de soro fisioldgico, que foram replicados por todos
0s quartos, embora dispostos em posicdes diferentes: umas camas ndo tém colchéo, outras
tém-no fora de sitio, ha postes caidos no chdo ou sobre as camas. Também a porta de entrada
dos quartos foi modelada e replicada, embora umas estejam logicamente mais abertas do que
outras. Os espacos das janelas foram preenchidas por caixilhos sem vidro, dado que, a
distancia que iriam ser vistas, 0s possiveis reflexos que causariam ndo seriam visiveis. Foram
modelados canos, que atravessam toda a extensdo do corredor, suspensos do tecto, assim
como uma série de candeeiros de ldampadas fluorescentes. As ombreiras das portas e as calhas
de madeira foram modeladas no sitio adequado e posteriormente “destruidas”, ajudando a dar
a ideia de um local maltratado; pedacos de tdbuas foram posicionados pelo chdo do corredor,
préximos da parede onde eventualmente ja haviam pertencido, passando a ilusdo de que

cairam por si e foram sendo amontoadas por quem precisou de passar pelo local.

Fig. 4.7 — O corredor do hospital

Fig. 4.8 — O quarto
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4.2.1.2 O Laboratério

O laboratdrio consiste num espaco limitado por quatro paredes, de forma rectangular,
com uma Unica porta para o corredor. Esta porta é diferente da utilizada para os quartos, pelo
que foi modelada em separado. O espaco do laboratorio € ocupado por incubadoras e
computadores - cujo design foi concebido pelo autor - e cadeiras executivas. A disposic¢ao das
incubadoras foi estudada de modo a que fosse possivel que um dos personagens pudesse
disparar sobre o outro no momento em que o Ultimo estivesse a analisar a unica incubadora
vazia, sem que houvesse outras incubadoras entre eles. Dentro de cada incubadora, foi

colocado um modelo replicado do clone, com excepc¢do de uma delas, de onde ele tera fugido.

Fig. 4.9 — O laboratorio

4.2.1.3 Os Lavabos

7

A parte do cenario destinada aos lavabos é naturalmente preenchida pelos diversos
elementos que constituem quaisquer sanitarios publicos: sanitas, lavatorios, espelho, etc,
todos modelados com o aspecto mais realista possivel. As paredes foram revestidas por
azulejos, cujos mosaicos foram, a seguir, alterados e/ou removidos, resultando num aspecto

arruinado. O espelho foi também modificado de modo a que ficasse partido de cima a baixo.

Fig. 4.10 — Os lavabos
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4.2.2 Modelacédo dos Personagens e Acessorios

Ciente de que o atraso de um més com que O projecto viria a ser iniciado iria ser
prejudicial para a sua producdo, o argumento foi criado de modo a que s6 um personagem
tivesse que ser modelado; assim, pode dedicar-se mais tempo e aten¢do ao modelo e aos seus
detalhes. O modelo foi, entdo, iniciado no software Maya, recorrendo as imagens de
referéncia criadas para o efeito, transitando posteriormente para o software ZBrush, onde o
seu rosto, maos e roupa foram detalhados de forma a alcancarem um aspecto mais organico e
realista. Os seus acessorios ndo foram editados no ZBrush; a arma, uma Desert Eagle, foi o
acessorio que obteve mais atengdo, dado que iria ter bastante protagonismo no filme, tendo

tido como referéncia numerosas fotografias da sua versao real.

Fig. 4.11 — O modelo do personagem

Fig. 4.12 — O modelo do arma
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4.2.3 Texturizagéo

A fase de texturizacdo envolveu imensa pesquisa e experimentacéo; a texturizacdo dos
cenarios foi na sua maioria bastante editada no software Photoshop, onde, sobretudo, o
aspecto final de tudo o que fosse paredes e portas tomou forma. As texturas das sanitas e
lavatorios foram também bastante trabalhadas, na tentativa de se lhes conceder uma aparéncia

velha e suja.

No laboratério, o maior desafio de texturizacdo foi 0 monitor simultaneamente animado e
transparente do computador; com ajuda dos programas Photoshop e After Effects, criou-se um

pequeno video que foi aplicado depois ao monitor.

Fig. 4.13 — Excerto do video que foi aplicado ao monitor Fig. 4.14 — O monitor mostrando o video, em pleno cendrio

A texturizacdo do personagem também passou pelo Photoshop, onde foram utilizados
varios tons da cor de pele para se tentar alcancar um aspecto o mais realista possivel. O
resultado final ndo foi o desejado, uma vez que ndo houve tempo suficiente para se
experimentar e utilizar uma técnica que seria mais apropriada para uma pele realista, 0

Subsurface Scattering®.

Os problemas que decorreram da utilizacdo de aplicativos geradores de pélo e cabelo, ja
anteriormente mencionados, fizeram com que se recorresse a texturizagdo para, bem ou mal,
colmatar essa falha; o cabelo e barba do personagem foram, assim, criados no Photoshop, o

que reduziu o nivel de realismo do personagem.

As roupas e acessorios, a excepcao do calgado e da arma do personagem principal, ndo
foram texturizadas, tendo sido apenas coloridas com uma cor base. O calgado foi texturizado
a partir da montagem de fotografias de varias perspectivas de uma sapatilha. A arma foi

texturizada com imagens de metal riscado e lettering criado no Photoshop.

Y mecanismo através do qual a pele do personagem, ao ser atingida pela luz, assume um aspecto mais préximo daquele que acontece na
realidade
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4.2.4 Rigging

Numa perspectiva de tomar um atalho e poupar tempo, recorreu-se ao aplicativo The
Setup Machine, como ja anteriormente referido, para se criar o esqueleto animavel do
personagem. Esta veio a revelar-se uma solucdo bastante problematica, na medida em que
dificultou descomunalmente o processo de animacgéo; muitas vezes surgiam deformacgdes no
corpo do modelo que eram impossiveis ou demasiado dificeis de se resolver. A pintura de
pesos’ que, em situagBes normais, seria a solugdo ideal, revelava-se muitas vezes ineficaz.
Assim, teve que se contornar este grande obstaculo através de posicionamentos da camara que
deixassem de fora as partes afectadas do modelo, de limitagdes na animagdo ou do posterior

encobrimento em p6s-producéo.

Fig. 4.15 — Personagem com rig aplicado

O rosto do personagem esteve para seguir praticamente 0 mesmo caminho, através da
utilizacdo do aplicativo The Face Machine, que segue 0S mesmos principios que o anterior.
Para que o personagem pudesse falar e esbocar diferentes expressdes faciais, iria utilizar-se
este método para se criar um sistema de controladores que permitiria formar qualquer
expressdo. Contudo, o The Face Machine deu problemas logo ao inicio, aquando da sua
aplicacdo ao rosto do personagem, pelo que teve que se recorrer a outro método, baseado em
blendshapes, ou seja, em expressdes faciais previamente criadas. Desta forma, 0 personagem
ficou privado de esbogar uma infinidade de express@es faciais, tendo ficado limitado as pré-

concebidas e a possivel combinacéo entre elas.

Para além do personagem, foi também criado um controlador para a arma, lanterna e
incubadora. O controlador da arma permite animar a sua patilha de seguranga, o slide, o
gatilho e o martelo. O controlador da lanterna permite ligar ou desligar a luz. O controlador da

incubadora permite abrir e fechar a porta de vidro.

1 . . . x . x - ~
processo através do qual se define quais as zonas do modelo que séo afectadas pela movimentagéo de uma articulagéo do esqueleto
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4.2.5 Animagéo

O processo de animacdo ndo foi tdo agradavel quanto inicialmente se esperara. Com
todos os problemas que o aplicativo de criacdo do rig trouxe, a experiéncia de animacéo
tornou-se algo incobmoda, além de que teve que ser relativamente apressada, devido ao atraso.

Contudo, fez-se um enorme esforgo por obter os resultados pretendidos.

Foi criado, numa primeira fase, o blocking da animacdo, isto é, a coloca¢do dos
personagens somente nas suas principais poses ao longo do filme, sem a animacéo resultante
da passagem de uma para outra. SO quando esta fase foi dada como pronta, se deu lugar a

animacdo propriamente dita.
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Fig. 4.16 — Frames da montagem do blocking

Seriam, portanto, dois 0s personagens a ser animados: 0 agente Cole e o0 seu clone. A fase
da animacdo iniciou-se com a criacdo dos seus ciclos de marcha e de corrida; nesta altura,
procurava-se ja transmitir-lhes as suas proprias personalidades: Cole assumiria um
comportamento disciplinado, de acordo com a conduta de um agente de autoridade, agindo
sempre conforme demandassem os protocolos, enquanto que o seu clone seria, de certa forma,
0 contrario, actuando de forma bruta, indisciplinada e agressiva. Desta maneira, criou-se um
jogo de contrastes e semelhancas, ou seja, embora 0s personagens sejam fisicamente
idénticos, os seus movimentos e acgdes sdo opostos. Um exemplo disso é o clone disparar
sempre que assume ser possivel atingir Cole, enquanto que o agente nunca chega a disparar,

por querer apreender o desconhecido e possivelmente vir a interroga-lo a fim de perceber a
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razdo da sua presenca naquele local. Assim, o ciclo de marcha de Cole assumiu duas formas:
uma em que ele se desloca de modo descontraido, iluminando com a lanterna a medida que
vai avancando e inspeccionando o local, e outra em que ele avanca mais cautelosamente, de

arma apontada. O ciclo de corrida do clone assumiu uma unica forma, em género de fuga.

Posteriormente, foram criadas as restantes animagdes dos personagens, como as suas
acgBes com as mdos segurando a arma e a lanterna, os movimentos de cabeca, 0s pontapés nas

portas, etc.

A animacdao facial ficou para ultimo, criando-se, entdo, as blendshapes que viriam ou nédo
a ser utilizadas. A seguir, chegou a altura de fazer a sincronizacao labial, ou seja, a animacao
dos movimentos dos labios do personagem de acordo com a gravacdo da voz que lhe seria
atribuida. Esta foi uma etapa algo intrépida, na medida em que foi a primeira vez que o autor

fez algo semelhante.

Houve bastante estudo dos movimentos, quer corporais, quer faciais, antes de serem
transpostos para 0s personagens: procedeu-se a andlise e criacdo de poses que se revelassem
fortes no ecrd e recorreu-se ao espelho e a filmagem para captacdo de referéncias o mais

adequadas possivel.

A discussdo aberta em aula com os colegas e professores também se revelou preciosa,
uma vez que diferentes pontos de vista ajudam a perceber quais as falhas que devem ser

colmatadas ou as potenciais melhorias a serem feitas.

4.2.6 lluminacgéo

Embora ndo fosse suposto, a partida, o processo de iluminagdo ser uma area de interesse
e de especial atencdo, acabou por vir revelar a extrema importancia que tem em qualquer
filme. A iluminacdo de um cenario atribui-lhe todo o ambiente e disposicdo que precisa para

captar o interesse e compreensdo por parte do espectador.

No inicio desta fase, Pierre Pages® foi convidado a deslocar-se & Universidade e conceder
algumas horas aos projectos de todos os alunos do 1° e 2° ano do Mestrado. Embora nao
tivesse havido tempo suficiente para que ele analisasse e transmitisse as suas opinides quanto
a todos os cendrios existentes em The Night Shift, as suas sugestfes quanto ao corredor do

hospital foram valiosas e tidas em conta no processo da sua iluminacao.

1 Pierre Pages trabalha na empresa Framestore em Londres, um dos maiores estidios de efeitos visuais e animacéo por computador da
Europa, tendo participado na concepcéo da iluminagéo do filme Legend of the Guardians (Zack Snyder, 2010).
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Mais uma vez, as referéncias adoptadas para 0s cenarios desempenharam um papel vital;
era uma grande vantagem que o espectador se sentisse familiarizado com determinados
aspectos do filme, para que inconscientemente suscitasse nele as sensacdes proprias de cada
ambiente. Assim, a atmosfera dos corredores de hospital da série de videojogos Silent Hill, o
azul fluorescente e predominante do filme Tron e a iluminagdo amarelada da casa de banho de
Splinter Cell: Conviction ajudaram a definir o tipo de iluminagdo/escuriddo que seria

necessario para alcancar o resultado pretendido.

Fig. 4.16 — Frames renderizados, mostrando a iluminacéo de cada um dos cenarios

4.2.7 Renderizagao

Devido ao atraso inicial, a inexperiéncia com o processo e a problemas decorrentes de
rapidas experimentacdes, a renderizacdo foi feita sem recurso a render passes, que
permitiriam obter diferentes camadas da imagem final do filme, cada uma com a sua
informagdo: brilhos, sombras, reflexos, etc. Esta metodologia facilitaria enormemente o
posterior processo de pos-produgdo, uma vez que cada uma dessas camadas poderia ser
independentemente editada. Assim, a renderizagdo foi, no geral, feita numa sé camada, que
abarcou todas essas informagdes e resultou numa menos bem conseguida imagem final. A
unica excepcao foi a sequéncia do laboratorio, em que se conseguiram criar render passes

para os reflexos e incandescéncias.
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4.3 P6s-Producéo

A fase de p6s-producdo destina-se & montagem de todas as imagens finais e consequente
edicdo, corrigindo cores, brilhos, contrastes e qualquer outro tipo de problema de imagem. O
programa utilizado para o efeito foi o After Effects. As imagens de The Night Shift
precisaram todas de uma alteracdo tonal, de modo a realgar e contrastar 0s personagens e 0S

diferentes elementos cénicos.

As cenas do laboratdrio tiveram atencdo especial devido as luzes azuis que se pretendiam
incandescentes. Como tal, atribuiu-se o efeito de incandescéncia a devida camada. Nesta
altura, surgiu um problema: o efeito de incandescéncia ndo surgia nas luzes reflectidas. A
solucdo parecia passar pela atribuicdo do mesmo efeito & camada de reflexos, mas isso
significava que tudo quanto fosse reflectido seria incandescente, incluindo o reflexo dos
elementos do cenario e do proprio personagem. Uma vez que isso ndo era desejavel, a solucao

consistiu em utilizar méascaras que retiraram o efeito dos reflexos devidos.

A faixa sonora foi concebida por um colega do Mestrado em Design de Som, Luis
Pessoa. A colaboracdo ficou longe de ser perfeita, e o resultado final demonstra muitas
fraquezas; alguns dos efeitos sonoros parecem ndo ser os adequados, como o som do click da
lanterna e principalmente o som do corpo de Cole a cair ao chao quando é atingido pelo clone.
Ficou patente também alguma dessincronizacdo, ndo s6 das falas em geral, mas também de
outros sons, como os das portas dos lavabos. No entanto, numa perspectiva geral, o resultado
final ficou positivo; a criacdo de um tema musical especificamente para o filme foi um ponto
favoravel, além de que se faz ouvir nos momentos mais adequados, ajudando a criar tenséo no

espectador.

4.4 Conclusdo de Capitulo

O atraso inicial do projecto encurtou imenso cada uma das fases do projecto, apressando-
as ao ponto de retirar muita da satisfacdo que inicialmente se esperara ao processo de
desenvolvimento. Alguns dos métodos de trabalho utilizados revelaram ndo ser o melhor
recurso, como foi o caso do aplicativo The Setup Machine, que acabou por se tornar um
manancial de problemas. Em todo o caso, o empenho no projecto foi enorme e constante,
nunca se desistindo perante 0s imensos pequenos e grandes obstaculos que se foram
levantando, tendo-se encontrado sempre algum tipo de solucdo. Por outras palavras, a

experiéncia que este projecto constituiu ndo se limitou apenas a aplicacdo de conhecimentos
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ja adquiridos; consistiu numa constante aprendizagem e esforco mental, que permitiu alvitrar

modos de contornar todas barreiras que surgiram pela frente.

A adopcdo de referéncias visuais para todo o tipo de vertentes do filme, como o aspecto
do personagem, dos elementos cénicos, a iluminacdo, e até a propria criacdo de referéncias
para animacgdo sdo métodos que ajudam grandemente a estipular e seguir um rumo objectivo

que, de outra forma, seria demasiado largo e impreciso.

The Night Shift constitui o primeiro grande projecto realizado por um autor que esta, no

final de contas, orgulhoso do resultado que alcangou.
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5 Conclus0es e perspectivas de trabalho futuro

Cada vez mais uma parte do nosso dia-a-dia, 0 CGI ndo para de evoluir e de se alastrar a
diversas areas para além do cinema e dos videojogos. Com a pesquisa efectuada para a
presente dissertacdo, aprendi imenso sobre as suas origens e potencialidades e fiquei a
conhecer alguns dos artistas mais relevantes da area e seus principais trabalhos. Também a
concepcdo de um guido completo para a modelacdo de uma cabega humana realista para
animacdo ajudou a interiorizacdo do processo e a ambientagdo com o software e suas

ferramentas de modelacéo.

The Night Shift tratou-se de um projecto relativamente ambicioso para uma s6 pessoa,
com a agravante de ter sido iniciado com um més de atraso. No entanto, além de ter
constituido um desafio e um longo processo de aprendizagem, foi também uma oportunidade

de criar algo meu, dentro dos meus interesses, 0 que me motivou ao longo da sua concepcao.

A aberta troca de ideias e sugestdes entre professores e alunos na aula potenciou o
constante aperfeicoamento do projecto; a certa altura, de tdo imerso que uma pessoa se
encontra em algo, deixa de ter objectividade perante qualquer questdo. As opinides de alguém
de fora, que nunca vira ou que s6 via de longe a longe o meu trabalho, tornaram-se bastante
importantes, na medida em que me ajudavam a perceber o que ndo resultava para alguém que

via o filme pela primeira vez.

Agquando do inicio da presente dissertacdo e do proprio Projecto Final, a grande questao
gue me colocava era quanto ao cargo que desejaria ocupar no mundo do trabalho, se o de
animador ou o de modelador. Outra questdo permanece ainda relativamente a area concreta:
cinema ou videojogos? Embora ainda ndo tenha encontrado respostas definitivas, o Projecto
Final - e consequentemente todos os problemas decorrentes do mesmo - fez-me orientar o
foco de interesse para a modelacdo, uma vez que a animacao se tornou tdo problematica. A
modelacdo em Maya é ja, sem duvida, uma area bastante confortavel, embora a animacao

roube ainda bastante do meu interesse.

Aproxima-se o final do curso e, com ele, a altura de tentar a minha sorte no mundo do
trabalho. Nesse sentido, as minhas candidaturas serdo, em principio, orientadas para a
obtencdo de um cargo profissional como modelador 3D de superficies duras. Assim que se
exercite durante mais uns tempos a modelacdo em ZBrush, sera ponderada a tentativa de um
cargo como modelador de personagens organicas, até porque a presente dissertacdo acaba por

se tratar de um passo nessa direcgéo.
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Ainda que se tenha tratado de um projecto amplo e trabalhoso, The Night Shift ndo serg,
a partida, suficiente para constituir um portfolio com o potencial suficiente para me levar a
ingressar numa grande empresa da area dos efeitos visuais para cinema ou videojogos. Ainda
assim, com recurso a outros projectos do passado e do futuro préximo, criarei 0 mais
brevemente possivel um portfolio que sera enviado para uma vasta lista de empresas nacionais

e internacionais, na expectativa de que alguma me abra as suas portas.

O futuro que se afigura mais provavel serd, porventura, e na melhor das hipéteses, a
obtencdo de um cargo na area em solo portugués. Seria uma oportunidade para obter a
experiéncia de trabalho que normalmente as grandes empresas requerem do pessoal que
contratam. Aliando a esse factor a concepg¢éo de trabalhos independentes que pretendo virem
a ser cada vez mais complexos e ambiciosos, serd, entdo, uma boa ajuda para a conquista do

cargo desejado.
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Anexo A: Cronologia de eventos do CGI

Ano Filme Efeito de CGI
1973 Westworld Primeira utilizagdo de imagens 2D digitalizadas num filme.
1976 Futureworld Primeira utilizacdo de gréficos 3D para uma mao e um rosto humano animados. Utilizacdo de
composicéo digital 2D para materializar personagens sobre um cenério.
1977 Star Wars Primeira utilizacéo de graficos vectoriais 3D
1978 Superman Primeiro genérico gerado por computador.
1979 Alien Utilizacdo de gréaficos computadorizados nos ecras de bordo da nave espacial.
1982 Tron Uso extensivo de CGI 3D, incluindo a famosa cena de corrida de lightcycles.
1984 The Last Starfighter Utilizagdo de CGI em todas as cenas de naves espaciais. Primeira utilizacdo de “CGl integrado”,
em que é suposto os efeitos representarem objectos reais.
1986 Luxo Jr. Primeira curta-metragem de animacéo inteiramente em 3D. Primeiro filme CGI a ser nomeado
para um prémio da Academia.
1991 Terminator 2 Primeiros movimentos humanos realistas numa personagem CG.
Beauty and the Beast Integracéo de personagens animadas do modo tradicional em cenario de graficos tridimensionais.
1993 Jurassic Park Combinagéo de modelos fotorrealistas de dinossauros criados em computador com reprodugdes a
escala real.
1994 Forrest Gump Integracdo de Tom Hanks em filmagens antigas. Remocéo digital das pernas de Gary Sinise.
1995 Toy Story Primeira longa-metragem de animacéo CGI.
2001 Final Fantasy: The Primeira longa-metragem CGl realista.
Spirits Within
2002 The Lord of the Rings: | Milhares de guerreiros gerados por computador.
The Two Towers
2003 Matrix Reloaded Gravacao tridimensional da actuacédo do actor e posterior edigdo e renderizagao.
2004 The Polar Express Primeiro filme CGl a utilizar captagdo de movimentos para todos os actores.
2007 Beowulf Recriacéo digital de todos os actores.
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Anexo B: DVD

O DVD em anexo contém a curta-metragem de animacdo The Night Shift, tema central
da presente Dissertacdo de Mestrado e produzido pelo autor da mesma.
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Anexo C: Cronograma

1° Semestre

Novembro

Modelagéo do Rosto Humano Realista

Model Sheet Cara

Modelagdo Cara

Modelacéo Corpo

Mock up Cenério

UV's Personagens e Cenario

Texturizacdo Personagem

TurnTable Personagem

Rig

Cenério Finalizado

Janeiro

Do|Sg‘Te‘Qa‘Qi‘Sx

16 17 18 19 20 21 22
23 24 25 26 27 28 29
30 31
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2° Semestre

Fevereiro

Te

Blocking
Apresentacdo Blocking
Animagéo

Marco

Aula com Ed Hooks
Apresentacdo Animagdo
Aula com Pierre Pages 11-13 Mar

lluminagédo
Apresentacdo lluminacéo

Renders
12 Apresentacdo Final
Pés-Produgdo

Merging
Screening Final
Estagio
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